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Chapter  1

Introduction

This chapter introduces you to text conventions used in the BlackTrax User’s Guide, provides 
information for troubleshooting, and lists contact information if you need further assistance.

In this chapter
About this manual  2

Troubleshooting  3

Welcome to BlackTrax  4
Reference Guide 1
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About this manual

Introduction

This manual provides instructions for the installation, configuration and operation of the BlackTrax 
system.

Text conventions

The following text conventions are used in this manual:

 Menus and menu commands appear in Arial bold. For example, “To open the camera window if 
closed, go to the View menu and click Cameras.”

 User interface elements such as buttons, tools, shortcuts, and dialog boxes appear in Tahoma 
Oblique. For example, “To close the project, click Yes.”

 Keyboard keys are indicated in ALL CAPITALS. For example, “To call up the save menu, enter in the 
command CTRL+SHIFT+B.”

 References to manuals appear in italic underlined font. For example, “For an in depth 
understanding on WYSIWYG and its capabilities, please refer to the WYSIWYG Reference Guide.”

 Instructions to direct you to different features of the BTSystem or areas in the physical Space are 
indicated in dark blue underlined. For Example “In the Space, take the BTBeacon.”
2
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Troubleshooting

Introduction

If you have problems using your software, please consult the following resources:

 The contents of this manual
 The Cast Software Web site at www.cast-soft.com
 Your designated BlackTrax Expert (BTE)

If these resources are insufficient, please contact CAST Technical Support.

Errors Icon

Be alert for Error icons that may appear in BlackTrax. A Error icon indicates that there is a problem 
with the project, specifically with the part branded by the Error icon. Objects that have a Error icon will 
not function. 

Common reasons an Error icon can appear are:

 A project update was preformed, and the object was not present in the update - When 
updating an existing BlackTrax project, it is possible that information used by the project was 
removed or not present in the update. The project will need to be updated with the missing 
information to use it again.

 The device is powered off - If a module or connected fixture has an error, it is possible that 
there is no power cycling through the device. Powering on the device should correct the error.

Help from Technical Support

For assistance with a problem, contact Technical Support directly at one of the offices identified below. 

When calling for help, please have the following information ready:

 BlackTrax serial number

North America

CAST Software

Technical Support

35 Ripley Avenue, Unit 1

Toronto, ON M6S 3P2

Canada

Phone: +1 877 989 2278

Fax: +1 416 597 9594

E-mail: techsupport@cast-soft.com

Web site: www.cast-soft.com
Reference Guide 3
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Welcome to BlackTrax

Introduction

BlackTrax is a powerful, customizable solution that can track anything that needs tracking inside a 
predefined area, the Space. Use it alone to connect media servers, 3D spatial audio, robotic cameras 
and moving lights, or connect them all together with anything else that needs to be tracked. BlackTrax 
is robust, universal, and unassuming - it performs almost any tracking task you can devise with real 
time accuracy. 

BlackTrack is the essential tool if you are looking to preform:

 Positional Tracking – The BTBeacon’s position (X,Y,Z) and orientation (roll, pitch, yaw) is tracked 
by the BTSystem. This means you will know the precise location of anything you are interested in 
tracking.

 Light Tracking – By placing a BTBeacon on a Trackable, be it a person or object, and setting a 
relationship to some fixtures, BlackTrax grants these fixtures the ability to follow Trackables’ 
position. By extending positional tracking using inverse kinematics, BlackTrax calculates the DMX 
values to send to a lighting console, allowing lights to follow this Trackable in real time as they 
move around, without any pre-planned paths or lighting cues.

 Spatial Surround Sound – By knowing the location of a Trackable, and streaming this position in 
real time to an audio client, an audio client can utilize this positional information in its synthesizing 
software. This will allow the audio client to deliver a 3D spatial surround sound experience to an 
audience.

 Media Content Manipulation – By streaming a Trackable position in real time to a media client, 
the media client can incorporate this positional data into the variables driving or effecting the video 
content, creating an interactive experience.

 Lighting Calibration – After preforming calibration of the BTCameras, BlackTrax can preforming a 
calibration routine on connected fixtures. This will instruct moving fixtures to focus on a BTBeacon 
in the Space, and based on this data, precisely calculate the real-world positions of these fixtures. 

 WYSIWYG Visualization – Using the included BlackTrax edition of WYSIWYG included with the 
system, you can visualize the interactions between BTBeacons (and the associated people and 
objects Trackables) moving around the Space, and the lights following them.
4
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Chapter  2

BlackTrax System Overview

This chapter provides a brief understanding of the BTSystem and define its various modules. It provides 
information on how to install and configure the BTSystem.

In this chapter
BTSystem Modules  6

Not Included Mandatory Components  17

Optional Components  18

BTSystem Hardware Configuration  19

System Procedures  21

Camera Installation  22
Reference Guide 5
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BTSystem Modules

System modules
 (1) BTServer

 WYSIWYG BlackTrax Edition (pre-installed software)
 BlackTrax Tracking Tools (pre-installed software)
 BlackTrax GUI (pre-installed software)

 (1) Timekeeper
 (2) Ferrites

 (1) eSync Controller
 (6) BTCamera
 (2) BTBeacon
 (20) Pulsers 
 (1) Charging Station
 (1) BTCalibration Kit

 (1) BTCalibration Wand Head
 (1) BTCalibration Telescopic Wand Handle
 (1) BTCalibration Ground Plane
 (1) BTCalibration Power Unit
 (3) LED Diffusers

Not Included Mandatory Components

 Category 6 Ethernet cable
 Power over Ethernet (PoE) gigabit Switch with Virtual LAN

Optional Components 

 DMX/Ethernet Node (for tracking with moving lights)
 Additional Power over Ethernet (PoE) gigabit Switches

BTServer

Physical Characteristics

 Width: 1’7” 
 Height: 7”
 Depth: 2’2” 
 Operating Temperature: 0°C to +40°C

Input/Output

 Data: Ethernet
6
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Timekeeper

Product ID

 FCC ID: RKT-BTTKV01
 IC: 10858A-BTTKV01
 Model Number: BTTKV01

Physical Characteristics

 Width: 2.245” 
 Height: 2.8” 
 Depth: 1.013” 
 Operating Temperature: 0°C to +40°C

Input/Output & Power

 Data: Ethernet, Radio 2.4 (GHz) 10Hz
 Power: 48VDC/15.6W from PoE Network Switch via Ethernet port (No input power via USB port)
Reference Guide 7
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Status LEDs

 3 LED lights

LED # LED Color Significance 

1 Red Radio RX

Green Radio TX

2 Red Undefined

Green Undefined

3 Red Power Indication (3.3v)

Green Serial Sync packet

 

Timekeeper functions

The Timekeeper is a single wireless access point that uses a proprietary radio system running on 2.4 
Ghz frequency to receive and send data from all BTBeacons. Data received includes IMU data for 
calculating the BTBeacon’s orientation, position, button presses, battery status, and configuration 
details. Data sent includes a signal used to synchronize the BTBeacons with the BTCameras, and 
configuration commands sent to the eSync Controller.

Ferrites 

Product ID

 Manufacturer: API 
 Model Number: BF1835

Physical Characteristics

 Width: .70
 Height: .77”
 Depth: 1.37” 
 Center Diameter: .35”
 Operating Temperature: 0°C to +40°C
 Impedance: 172 Ohm

Ferrite Functions

The ferrite filter is cylindrical clamp fastened over cables to meet interference requirements. One ferrite 
filter is clamped over the cord connecting the Timekeeper to the switch, the other clamped over the 
cord connecting the Timekeeper to the eSync Controller. Both ferrite filters should be fastened on their 
cords as close to the Timekeeper as possible.
8
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eSync Controller

Physical Characteristics

 Width: 5.47”
 Height: 1.61” 
 Depth: 3.64” 
 Weight: 13 oz
 Operating Temperature: 0°C to +40°C

Power 

 IEEE 802.3af-2003 PoE

Ethernet Port

 100BASE-TX Ethernet
 Cat6 Ethernet cabling
Reference Guide 9
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Status LEDs

 Per port activity status
 Master time
 External lock
 Ethernet link status
 Ethernet activity

eSync Functions

The eSync synchronizes the BTCamera so that the camera shutters open and close simultaneously in 
sync with the pulsing of the BTBeacons' pulsers. Other commands sent to the cameras include 
exposure, and whether to use the infrared or visible spectrum of light.
10
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BTCamera

Product ID

 Model Number: S250e

Physical Characteristics

 Case: Aluminum and Polycarbonate
 Width: 3.19” 
 Height: 3.15” 
 Depth: 2.66” 
 Weight: 15.2 oz
 Mounting: 1/4”-20 tripod thread
 Status Indicators:

 2 digit numeric LEDs
 1 internal LED

 Operating Temperature: 0°C to +40°C

Lens & Filter

 Stock Lens: 5.5 mm F#1.8 (wide band AR coated)
 Optional Lens: 8 mm F#1.8 (wide band AR coated)
 M12 Lens Mount
 Adjustable focus with wave spring assist
 800nm IR long pass filter with Filter Switcher
Reference Guide 11
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Image Sensor

 Resolution: 832 × 832
 Frame Rate: 30–250 FPS (adjustable)
 Accuracy: Sub-millimeter
 Latency: 4 ms
 Shutter Type: global
 Shutter Speed:

 Default: 500 µs (0.5 ms)
 Minimum: 10 µs (0.01 ms)
 Maximum: 3,800 µs (3.8 ms) at 100 FPS

Input/Output & Power

 Data: Ethernet (100BASE-T)
 Camera Sync: Ethernet
 Power: PoE

Camera Functions

BTCameras are used to determine BTBeacon positions in the Space. A BTBeacon's position in 3 
dimensions (X, Y, and Z) can be determined when two or more BTCameras have a direct line-of-sight to 
the Pulser. This information is then sent to the BTServer.
12
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BTBeacon

Product ID

 FCC ID: RKT- BTBCV01
 IC: 10858A- BTBCV01
 Model: BTBCV01P

Physical Characteristics

 Case: Plastic with Velcro strap attachments
 Width: 1.945”
 Height: 3.18”
 Depth: .737”

Input/Output & Power

 Data: USB, Radio 2.4 (GHz) 10Hz
 Power: Rechargeable Lithium-ion Battery, charged by 5V USB
Reference Guide 13
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BTBeacon Status LEDs

LED # LED Color Significance 

LED 1 Solid Red Battery Charging

Solid Green Battery fully charged

Solid Orange Charge Error* - Discontinue Use

LED 2 Solid Red Error

Solid Amber Power/ No Error

Flashing Amber No IMU/No Error

LED 3 Solid Red Radio RX

Solid Green Radio TX

LED 4 Solid Green Power 100-50%

Solid Amber Power 50-20% 

Solid Red Power 20-10%

Flashing Red Power 10-0%

Off Power Off

Warning: *If a BTBeacon experiences a charge error, there could be a potential issue with the Lithium-
ion battery. Discontinue use immediately.

BTBeacon Functions

Each BTBeacon has three ports to power a Pulser with. When a Pulser is connected to a BTBeacon’s LED 
port, the BTBeacon will emit infrared light pulses through the Pulser LED. Each port of the BTBeacon 
pulses a unique code. When the LED pulse is seen by 2 or more BTCameras, the positional coordinates 
(XYZ) for BTBeacon are calculated by the BTServer. Position is based on the location of the Pulser LED. 
The pulse of each port on the BTBeacon is not shared by any other BTBeacons in that system. 

Orientation data (roll, pitch, yaw) is determined by an internal inertial measurement unit (IMU). The 
IMU also functions as a backup for determining the BTBeacon's position. The IMU measures acceleration 
and rotation. This data is used by the BTServer to calculate the BTBeacon’s position for up to 2 seconds 
when the BTBeacon Pulser LED is not visible to enough BTCameras. 

The BTBeacons has a red power and reset button, and two white auxiliary buttons. The auxiliary 
buttons are used during Fixture Calibration (blue link) and can also be used to trigger other effects as 
determined by 3rd party systems. 

BTBeacon transmit the following data over radio to the timekeeper and relayed to the BTServer: IMU 
sensor data, button presses, battery status, configuration details, Pulser IDs.

Currently a limit of 12 BTBeacon can be active at any one time. BTBeacon are docked in the Charging 
Station to recharge the BTBeacon’s battery, to update configuration settings, and to update firmware.
14
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LED Pulser

Physical Characteristics

 Length: 1’, 3’, 5’

Pulser function

When a Pulser is connected to a BTBeacon LED port, the LED portion of a Pulser will pulse the 
BTBeacon’s unique identifier signal. The pulse is viewed by BTCameras, sent to the BTServer and used 
to calculate the BTBeacon position in the Space.

Charging Station
Size and weight

 Case: Steel 
 Width: 6”
 Height: 3”
 Depth: 1’1”

Input/Output & Power

 Data: Ethernet, USB
 Power: 25 Watt

BlackTrax Charging Station Function

The Charging Station is a device used to recharge the battery of a BTBeacon. BTBeacons are connected 
to the Charging Station using the BTBeacon’s USB port. While connected the BTSystem can read the 
status of the battery, regulate charging and maximize battery life. 

The Charging Station can hold a maximum of 6 BTBeacons at one time. BTBeacons connected to the 
Charging Station have their functionality disabled while charging. BTBeacons connected to the Charging 
Station do not count towards the limit of BTBeacons that can be active simultaneously.

Calibration Kit

BTCalibration Wand Head

Size and weight

 Width: 41.7”
 Height: 10.6”
 Depth: 0.8”

BTCalibration Telescopic Wand Handle

Size and weight

 Width: 0.8”
 Height: 59”
 Depth: 0.8”
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BTCalibration Ground Plane

Size and weight

 Width: 30.3”
 Length: 38.6”
 Depth: 2”

BTCalibration Power Unit

Size and weight

 Width: 8.7”
 Height: 8.7”
 Depth: 1.8”

Power

 Power: 10 Watt

BTCalibration LED Diffuser

Size and weight

 Size: 1.6”

BlackTrax Calibration Kit Function

The Calibration Kit is used for calibrating the BTCameras position in the Space. During calibration the 
Wand Head, attached to the Wand Handle and connected to the Power Unit, moves inside the Space. 
During calibration BTCameras look for the Wand Head LEDs, which are covered by LED Diffuser. When 
multiple BTCameras see the LEDs, the BTSystem is able to generate data for camera calibration. 
BTCameras use this data to determine their position relative to each other. The Ground Plane, connect 
to the Power Unit, is placed in the origin of the Space. The BTSystem uses the Ground Plane to calculate 
BTCamera position relative to the ground.
16



April 2013 Not Included Mandatory Components 
Not Included Mandatory Components

Attention: BlackTrax requires additional components to function which are not included with purchase 
of the BTSystem.

Category 6 Ethernet cabling

All Ethernet cabling used to connect the system components together must be of Category 6 (Cat6) 
quality or greater. The amount needed will vary depending on the Space dimensions and user needs.

Attention: The maximum allowed length of a Cat6 cable is 100 meters. It is recommended that Cat6 
standards be followed when connecting modules together to ensure the BTSystem operates as 
intended. 

Power over Ethernet gigabit switch for BTCameras
BlackTrax requires a dedicated Power over Ethernet (PoE) gigabit switch to connect all the BTCameras 
with the rest of the system. The switch should be:

 A PoE gigabit switch.
 Possess a PoE port for each BTCamera, plus 3 extra to connect to the Timekeeper, eSync controller 

and BTServer.
 PoE switches must support 15.4 watts per Ethernet port.
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Optional Components

Depending on the purpose of tracking, you may need additional hardware components that are not 
included with the BTSystem.

DMX to Ethernet/Ethernet to DMX node for lighting

To connect BlackTrax with a lighting console, a DMX to Ethernet/Ethernet to DMX node is required. The 
following nodes have been tested and are approved to work with BlackTrax:

 ELC dmXLAN Node 8S
18
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BTSystem Hardware Configuration 

System configuration

It is recommended that all modules that connect to the BTServer except for the BTCameras be kept in 
the same area outside of the Space. The following diagram outlines a typical hardware configuration 
and how all BlackTrax modules connect to together.

Attention: The Timekeeper’s Ethernet port is designed to only connect to a commercially available 
Power over Ethernet (PoE) network switch. The Timekeeper is not designed to be a peripheral device to 
a Class B personal computer. As such, the Ethernet port shall not be connected to a Class B personal 
computer in any operating configuration.
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Optional equipment configuration

Depending on your tracking needs, additional components must be connected with the BTSystem. The 
following outlines how to connect this optional equipment with the BTSystem.

Additional Hardware Configuration for tracking with moving light fixtures
20
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System Procedures

Charging BTBeacons

BTBeacon can be charged using the Charge Station. BTBeacons are connected to the Charging Station 
using the Mini USB port found on the side of the BTBeacon. BTBeacons connected to the Charge Station 
become completely inoperative and do not transmit data. Charging BTBeacons do not count towards the 
limit of BTBeacons that can be active simultaneously.

Attention: The USB port of the BTBeacon is not designed to be a peripheral device to a Class B 
personal computer. As such, the user shall not connect the USB port to a Class B personal computer 
during normal operation.

Attention: The sole power source of the BTBeacon is the internal 3.7V rechargeable Lithium-ion 
battery. The BTBeacon does not require a connection at the USB port to operate

To charge a BTBeacon using the Charging Station

Connect the BTBeacon to the charge station via the Mini USB port found on the side of the BTBeacon. 

Result: The BTBeacon is charging. See the BTBeacon Status LEDs section to determine when the 
BTBeacon is fully charged.
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Camera Installation

Introduction

BlackTrax is designed to track any object, called a Trackables, within a predefined tracking area, called 
the Space. This Space is created when multiple BTCameras, installed around the perimeter of the 
Space, have overlapping fields of view. When 2 or more BTCameras view the same area, at the same 
time, that area can be tracked. 

Environment considerations for camera installation

The environment of the Space can have a great impact on the capacity of BlackTrax to function as 
intended. The following precautions should always be remembered when installing the BlackTrax 
System to minimize interference and make an optimal tracking environment. 

 Infrared Interference: External infrared sources and reflections can cause interference with 
camera tracking. For best results, ensure the tracking area is free from sunlight, lights which emit 
in the infrared spectrum, infrared based devices, and highly reflective materials.
For infrared sources and reflections which cannot be removed from the tracking area, there are 
provisions within the software to mask out the affected areas of the BTCamera's field of view. 
Note: Infrared interference is more of a concern during the camera calibration than during tracking 
operation. Since the system looks for special pulsed signals during tracking, there is some 
tolerance for other infrared sources. 

 Reflective surfaces: A Space that possess material that is reflective might reflect and mimic a 
BTBeacon’s unique LED pulse, creating errors with tracking. If this causes interference it is 
recommended that covering be placed to block reflections.

 Cabling: When setting up Ethernet connected BTCameras, remember that they are subject to the 
to the limitation of Ethernet communication standards. Ethernet cables can not be longer then 
100m for BlackTrax to function correctly.

 Camera Stability: Ensure that the location where you choose to install BTCameras is stable, 
sturdy and always stationary. Any movement of a BlackTrax camera will require recalibration of the 
entire camera system.

Example: If a camera is hung on a truss system which sways, the accuracy and performance of 
the system will be affected.
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Installing BTCamera Lens

To install BTCamera lens

Screw the lens onto the BTCam with the included wave spring between the camera and the lens. 
Tighten until proper focus is achieved.

Camera placement and orientation

In order for tracking to function correctly, multiple BTCameras must be arranged to have overlapping 
fields of view of the Space. A BTCamera field of view is the part of the Space that is visible through the 
camera while the camera is in a fixed position and orientation.

Attention: Good camera placement and orientation is absolutely critical to proper operation 
of the system! 
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Chapter  3

WYSIWYG for BlackTrax

This chapter provides information on how to use WYSIWYG for BlackTrax. WYSIWYG for BlackTrax is a 
separate program used to create the foundation of a BlackTrax project. BlackTrax draws upon the 
libraries and Space information within WYSIWYG, as well as using WYSIWYG to visualize activity.

In this chapter
.BTX File Creation  26

Planning Camera Placement  34

BlackTrax visualization  38
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.BTX File Creation

Introduction

WYSIWYG is an award winning program that offers lighting designers a customized 3D CAD, paperwork 
and rendering application which is included in the BlackTrax software suite. Using WYSIWYG you will 
create a virtual representation of the Space. If you are tracking with moving fixtures, fixture position 
and patching must also be included. WYSIWYG exports this information as a .btx file, which is then used 
by BlackTrax for tracking.

When connected to BlackTrax, WYSIWYG will also act as a visualizer for what is happening in the Space. 
Trackable and fixture movement can be fully simulated, using information from BlackTrax or other data 
sources.

The following section on WYSIWYG only covers use related to BlackTrax. For an in depth understanding 
on WYSIWYG and its full capabilities, please refer to the WYSIWYG Reference Guide.

Attention: Due to complexity of using WYSIWYG and making an accurate drawing, it is recommended 
that a BlackTrax Expert (BTE) be consulted for assistance as needed.

The Space in WYSIWYG

To use BlackTrax you must create a virtual representation of the Space in WYSIWYG. This virtual Space 
will possess vital information that BlackTrax requires: what the dimensions of the Space are, 
information on devices in use (Fixtures), and what objects or people you want BlackTrax to follow 
(Trackables). This section will guide you on creating the Space in WYSIWYG and aspects that have to be 
included. 

To track with moving fixtures in BlackTrax, the following steps must be taken in the creation of the 
WYSIWYG file:

 Create a virtual representation of the venue the Space is in.
 Define a common origin position (0,0,0 coordinate) in the Space.
 Hang moving fixtures approximately where they will be.
 Create avatars of Trackables.
 Patch Trackables for use with BlackTrax.
 Patch fixtures to DMX universe and assign Spot IDs.
 Patch DMX universes to console.
 Save the WYSIWYG project. 
 Export the WYSIWYG project for use with BlackTrax.

If you are NOT using BlackTrax for tracking with moving fixtures, only the following steps need to be 
completed:

 Create avatars of Trackables.
 Patch Trackables for use with BlackTrax.
 Save the WYSIWYG project 
 Export the WYSIWYG project for use with BlackTrax.

Creating the venue in WYSIWYG

Using the tools in WYSIWYG’s CAD mode, create an accurate scale representation of the venue the 
Space is in. The suggested minimum level of detail is that it contain the floor, the walls and any pipes, 
trusses or structural frames in which BlackTrax cameras or other moving fixtures will be attached. The 
more detailed the venue, the better looking and accurate the visualization will be.
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Note: Due to the complexity of recreating an accurate representation of a venue, it is recommended 
that the WYSIWYG User Guide’s chapter on “The CAD environment” is read for a thorough 
understanding. 

Defining the origin in WYSIWYG

Most objects in WYSIWYG are drawn as 3D objects, with width, depth, and height values using the 
Cartesian coordinate system of 3 working axes, X, Y, and Z. The point where the 3 axes meet is called 
the origin and the value of X, Y, and Z is 0 respectively (0,0,0). 

Origin requirements

The location of the origin needs to be inside the Space. It should be easy to see and determine in the 
physical Space. The location of the origin and how the axes are orientated needs to be consistent. The 
origin needs to be the same in WYSIWYG, in Tracking Tools, and in the Space. Inconsistencies will cause 
errors in the BTSystem and confuse tracking. The origin will also need to be visible to at least 2 
BTCameras for camera calibration to function.

To set the origin in WYSIWYG

1 In WYSIWYG, in CAD mode at the bottom of the screen, click the Wireframe view tab.

2 From the Tools menu, choose Set User Origin.

Tip: You can also use the Origin tool on the Tools toolbar.

3 Click a point on your drawing or type in the coordinates (X,Y,Z) that will assume the values 0,0,0. 
This point will remain 0,0,0 until you change it again.

Hanging moving fixtures in WYSIWYG

Any moving fixtures that you want to follow Trackables will need to be placed in WYSIWYG. By placing a 
fixture BlackTrax will be able to pull valuable information, such as the properties and capabilities of the 
fixture and its position in the Space. 

Fixtures will need to be connected to pipes or trusses to be hung. The position and orientation of the 
fixtures in WYSIWYG need to be close to where they will be in the actual Space for tracking to work 
correctly. Minor variations, up to 3m in distance and 10° in orientation from the actual position in the 
Space can be corrected during BlackTrax Fixture Calibration.

Note: It is recommended that the WYSIWYG User Guide’s chapter on “Hanging and focusing fixtures” is 
read for a complete understanding on how to hang fixtures. 

Attention: Only moving fixtures are capable of following Trackables.

To insert fixtures in WYSIWYG

1 In WYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.

2 From the Library menu, choose Browse Library. 

Result: The Library Browser window will open.

3 At the bottom of the Library Browser click the Fixture Tool .

4 In the menu that is now visible, double-click Manufacturer to select fixtures by manufacturer name, 
Type to select by fixture type, or All to see all the fixtures in alphabetical order.

5 Note: Alternately, you can use the Library Browser’s search function to locate the fixture that you 
want to insert. Simply type the name of the fixture (or a partial name) in the search box at the top 
of the Library Browser, and then click the search icon . 

6 Double-click the fixture name.

Result: A fixture with default settings for this type attaches to the cursor. 
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7 To change the properties of the fixture before inserting, in the Library Browser right-click on the 
fixture name. In the menu that appears click Properties.

Result: A dialog box opens with a shaded view of the fixture on the left and an image of its symbol 
on the right. Use the Photometrics tab to change the lamp and lens settings for the fixture, if 
applicable. 

8 To place the fixture, click over a hang structure.

Result: Copies of the fixture will attach to hang structures when clicked. Continue placing this type 
of fixture by clicking on the other hang structures as desired.

9 Finish placing this fixture type by right-clicking. In the menu that appears select Finish placing 
fixtures.

10 To place other fixture types, repeat the above steps for each type.

Attention: It is recommended that fixtures intended for tracking are not hanging directly 
over the space. When placing moving fixtures that are to follow Trackables, it is recommended that 
fixtures are not placed directly above the Space. Fixtures placed above the space may run into pan and 
tilt range limitations when attempting to follow a Trackable.

Smart practices for moving fixture placement 

To obtain the precise tracking in BlackTrax, the limitations of moving fixtures must be taken into 
account. The following section will guide you through known limitations of moving fixtures in BlackTrax 
and provide smart practices used to overcome these limits.

Do not place moving fixtures directly above the Space
If fixtures are placed above the Space and are following a Trackable which moves in a circular path 
underneath, this can cause fixtures to spiral and reach a pan stop.

When a Trackable moves almost directly underneath a moving fixture which is following it, the pan-
motion of the fixture must be very fast in order to remain pointing at the Trackable. It is likely that the 
moving fixture will not be able to move quick enough to track in this way and a lag in tracking will occur. 

Creating Trackables in WYSIWYG

Objects or people that are to be tracked are called Trackables. An avatar of each Trackable needs to be 
created in WYSIWYG. They can be represented by any library object found in WYSIWYG.

To create a Trackable in WYSIWYG

1 In WYSIWYG, in CAD mode, at the bottom of the screen click the Wireframe view tab. 

2 From the Library menu, choose Browse Library.

Result: The Library Browser window will appear on the right side of the screen.

3 At the bottom of the browser window click the  Library Items (scenic) tab to view the contents.

4 Navigate to the desired object you which to represent a Trackable.

Note: The actual look of the Trackable is purely cosmetic.

5 At the top of the Library Browser, click the Insert tool.

Tip: You can also double-click on the object name.

6 To insert the object, click in your drawing.

7 To stop inserting the object, right-click in the drawing. In the menu that appears, click Finish 
Library Item.

8 In the Draw menu choose Frame.

9 In the window that appears, type a unique name of the object Frame in the field. 
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10 Click OK.

11 In your drawing, in the Trackable object click the desired pivot point.

Result: A Frame will appear where the mouse was clicked. The Frame is represented as a 
Cartesian axis.

12 On the Trackable object you inserted into the drawing, right-click.

13 In the menu that appears, select Properties.

14 On the General tab, from the Attach to Axis drop-down list, select the unique name you created for 
the object Frame.

15 Click OK.

Result: The Trackable is created. It is represented as the inserted object and its motion is 
associated with the Frame.

Patching Trackables in WYSIWYG

After Trackables are created they need to be patched to a Motion Universe. The patch will allow the 
visualization of Trackable movement to occur in BlackTrax.

Note: It is recommended that the WYSIWYG User Guide’s chapter on “Data mode” is read for a 
complete understanding of patching. 

To create a new patch universe for Trackables

1 In WYSIWYG, in DATA mode, click the Patch layout tab at the bottom of the screen.

2 In the patch shortcut area at the left side of the screen, right-click.

3 In the menu that appears click New Patch.

Result: A dialog box is displayed, prompting for the type of universe that you want to create, and 
the name of the new universe.

4 Type a descriptive name for the patch universe in the empty field. 

5 Set the Patch Universe Type to Motion Control System.

6 Click OK.

Result: The patch universe for Trackables is created and a shortcut is created in the Patch shortcut 
area.

To patch a Trackable to a universe

1 In WYSIWYG, in DATA mode click either the H Select or V Select layout tab at the bottom of the 
screen.

2 In the wireframe drawing, right-click the Frame of the Trackable.

Tip: Remember that the Frame of the Trackable is the Cartesian axis associated with the 
Trackable, not the Trackable object itself.

3 In the menu that appears, select Properties from the menu.

4 Click the Axis tab.

5 In the Patch section, from the Patch Type drop-down list, select Motion Patch.

6 In the Motion Patch section, from the Universe drop-down list, select the patch universe you 
created to patch Trackables to. 

7 In the ID drop-down list, type the unique name of the Trackable.

Note: The ID should be unique for every Trackable. BlackTrax will associate the Trackable with this 
name.

8 Click Apply.
Reference Guide 29



.BTX File Creation  Release 1.0
9 Click OK.

Result: The Trackable will be patched to the motion universe. When WYSIWYG and BlackTrax are 
connected, Trackable movement will be visualized in WYSIWYG.

Patching and assigning an ID to fixtures in WYSIWYG

The patching of fixtures as they appears in the connected console has to be recreated in WYSIWYG. 
When tracking occurs, BlackTrax uses the DMX values generated by the console, but overrides the pan 
and tilt channels with new values. These new values instruct the fixture where it should be aimed to 
follow a Trackable. If a fixture is edited to have a persistent beam size, then the zoom and iris values 
will change as well. The patching needs to be the same so that BlackTrax knows where to override the 
DMX values.

Each fixture in the project will also need to be assigned an individual fixture ID. The fixture ID is used 
by the BTSystem to differentiate between fixtures in the project.

To create a patch universe

1 In WYSIWYG, in DATA mode, click the Patch layout tab at the bottom of the screen.

2 In the patch shortcut area on the right of the screen, right-click. 

3 In the menu that appears select New Patch.

4 Result: A dialog box is displayed, prompting for the type of universe that you want to create, and 
the name of the new universe.

5 Type the name of the patch universe. 

6 Under Patch Universe Type, select DMX.

7 Click OK.

Result: The patch shortcut appears in the Patch tab.

Fixture patching methods
There are multiple ways to patch fixtures in WYSIWYG. The following section will guide you through 
some of the simplest methods.

For more information see the WYSIWYG User Guide’s Data Mode chapter. 

To patch fixtures in using drag and drop
It is possible to drag and drop fixtures to the appropriate channel to patch them. This method is easy to 
use, but it can be tedious if there are many moving fixtures in the project.

1 In WYSIWYG, in DATA mode, click the Patch layout tab at the bottom of the screen

2 In the wireframe drawing, click and hold on the desired fixture.

3 Drag and drop the fixture to the desired patch location in the bottom half of the screen.

4 For re-patching, repeat the above steps, or click and drag the fixture’s patch information to the 
new location.

To patch fixtures and assign spot IDs using Quick Tools
Using Quick Tools, fixtures can be patched and assigned spot IDs by clicking on their Wireframe view 
image. The first fixture clicked will be assigned the patch and ID as configured in Quick Tools. The next 
fixture clicked will be assigned the next available channel in the patch and the next fixture ID in the 
sequence until you are finished using Quick Tools.

1 In WYSIWYG, in CAD mode, in Wireframe view, go to the Tools menu and click Quick Tools.

Result: The Quick Fixture Tool window will open.
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2 In the Quick Fixture Tool window, in the Fixture Attributes section, mark the Spot check box. 

3 In the Spot field, enter a number which will be the first fixture ID used in the sequence.

4 In the Fixture Data section, mark the Patch check box. 

5 In the Patch field, enter the universe and channel the first fixture will patching to, separated by a 
period. 

Example: “A.1” would patch to universe A, chapter 1.

6 Click Ok

Result: When a fixture is clicked on, it will be assigned a Universe and channel to operate on. The 
first fixture clicked will be assigned the to the channel number entered in Quick Tools. Subsequent 
fixtures clicked will be assigned the next sequential channel.

7 Click on a fixture to patch it to a universe and channel. Clicking on each fixture that you want 
patched and assigned a spot ID.

8 To stop patching fixtures, right click.

9 In the menu that appears, click Finish Quick Tools.

To patch fixtures and assign spot IDs using the data spreadsheet
In DATA mode, the Spreadsheet view has information on all fixtures created in the WYSIWYG project. 
Using the spreadsheet you can edit the patch information and Spot ID directly in the table.

1 In WYSIWYG, in Data mode, click on the Wireframe view tab.

2 In the Columns section on the left side of the window, click All Data (Sortable).

Result: All fixture data will be displayed in the spreadsheet. 

3 In the Patch column, enter the appropriate patch information for each fixture.

4 In the Spot column, enter a unique Spot ID for each fixture.

Tip: It is possible to assign sequential values to fixtures quickly by entering a value for the first 
fixture at the top of the list, then entering ALT + Down Arrow. The fixture below will be assigned 
the next available value. This can be repeated as necessary.

Patching DMX universes to a console

BlackTrax requires that the patching information of the connected console be recorded in WYSIWYG. 
This will inform BlackTrax which console is in use and which ports will transmit information.

To patch the DMX universe to a console

1 In WYSIWYG, in LIVE mode, go to the Live menu and click Device Manager....

Result: The Device Manager dialog window is displayed.

2 Click New. 

Result: The Library Selection window is displayed.

3 Navigate through the console library until you find the console or device that you are connecting 
to. Click the console name to highlight it.

4 Click Insert. 

Result: The console appears in the Device Manager.

5 With the console name still selected, click Properties. 

Result: The Properties dialog window is displayed.

6 From the Protocol drop-down list, select the protocol used by the console. 

Result: The console model is displayed in the Model field. The name of the console is displayed in 
the Name field. 
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7 In the Address field, type the designated address of the console, if applicable.

8 You must bind output ports from the console to WYSIWYG patch universes. Bind a Port output to 
the appropriate universe by clicking the Universe field next to the output.

Result: A drop-down list of available Universes is displayed.

9 Select the appropriate Universe from the list.

10 Repeat the above steps to bind all ports to their appropriate patch universes. 

11 Click Close to close the Properties window.

12 Click Close to exit the Device Manager.

Saving the WYSIWYG project

Once you have all the information on the Space in WYSIWYG created, The information will need to be 
saved as a WYSIWYG project file (.wyg). Save will save the open WYSIWYG project to the same file 
name and location under which it was previously saved. If you are saving the project for the first time, 
this command will perform Save As... . Save As... is used to save the current project with a new file name 
and/or a new destination.

To save the WYSIWYG project using Save

1 In WYSIWYG, from the File menu, click Save.

Result: A dialog window will appear.

2 In the window, navigate to where you want to save the project file.

3 In the File name field type in the name of the project.

4 Click Save.

To save the WYSIWYG project using Save As...

1 In WYSIWYG, from the File menu, click Save As... .

Result: A dialog window will appear.

2 In the window, navigate to where you want to save the project file.

3 In the File name field type in the name of the project.

4 Click Save.

Creating a .btx file in WYSIWYG 

After creating and saving the WYSIWYG project as a .wyg file, BlackTrax requires that the information 
be converted. The conversation will take all the valuable information that was put into the WYSIWYG 
project, and put it into the .btx formate that BlackTrax understands.

To convert a .wyg file to .btx

1 In WYSIWYG, from the File menu, click Open. 

2 Navigate to the .wyg file location, select the file and then click Open.

3 In the .wyg file, go to DESIGN mode.

4 Click the Wireframe view tab at the bottom of the screen.

5 In the Wireframe view, click inside an empty space of the wireframe.

6 Enter in the command CTRL+SHIFT+B.

Result: A pop-up window will appear.

7 In the window, navigate to where you want to save the .btx file.
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8 In the File Name field enter in the name of the .btx file.

9 Click Save.

Result: The WYSIWYG file (.wyg) will convert to the BlackTrax format (.btx) and be saved as a 
separate file. 
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Planning Camera Placement

Introduction

It is recommended that BTCameras are placed and aimed in WYSIWYG before you actually hang and 
aim them in the Space. This step is optional and will not affect the .btx file. Planning BTCamera 
placement in WYSIWYG will enable you to test BTCamera coverage and field of view overlap. 

In the Wireframe view BTCameras are hung around the perimeter of the Space on pipes. The BTCameras 
are represented as small yellow squares. 

Wireframe view of the Space venue in CAD mode. 

The Space in Shaded view, with BTCameras highlighted in green.
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In WYSIWYG you can choose the BTCamera and lens type and the BTCamera field of view will correctly 
project in the simulation. A BTCamera field of view of in WYSIWYG is depicted as a red beam with a 
cross hair in the center. 

BTCamera field of view in CAD mode Wireframe view. 

BTCamera field of view in Live mode, Shaded view. 

BlackTrax requires that two BTCameras see the same area at the same time for tracking to occur in that 
area. By positioning BTCameras in WYSIWYG, we are able to see where fields of view will overlap and 
tracking will occur. Only the area where the views overlap does tracking occur. 
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CAD mode Wireframe view of two BTCameras that have their field of view overlapping.

LIVE mode Shaded view of two BTCameras that have their field of view overlapping.
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To access BlackTrax cameras in WYSIWYG

1 In WYSIWYG, in CAD mode, click the Wireframe view tab. 

2 From the Library menu, choose Browse Library.

Result: The Library Browser window will open

3 At the bottom of the Library Browser window, click the Fixture tool .

4 In the menu that is now visible, double-click Manufacturer to select fixtures by manufacturer name, 
Type to select by fixture type, or All to see all the fixtures in alphabetical order. BlackTrax fixtures 
can be found in Manufacturer under CAST, in Type under BlackTrax.

Note: Alternately, you can use the Library Browser’s search function to locate the fixture that you 
want to insert. Simply type the name of the fixture (or a partial name) in the search box at the top 
of the Library Browser, and then click the search icon .

5 Double-click on the name of the BTCamera that you want to insert.

6 Result: A fixture with default settings for this type attaches to the cursor.

7 To change the properties of the fixture before inserting, such as the lens size, right-click on the 
fixture name, and then click Properties.

Result: A dialog box opens with a shaded view of the BTCamera on the left and an image of its 
symbol on the right. Use the Appearance tab to change the lens settings for the camera. Options are 
wide 5.5mm to narrow 8.0mm.

8 To place the BTCamera, move the mouse over a hang structure, and then click. Continue placing 
this type of fixture by clicking on the other hang structures as desired.

9 Finish placing this fixture type by right-clicking, and then choosing Finish placing fixtures from the 
resulting menu.

10 Click on a BTCamera.

Result: A red wireframe of the field of view will be appear. 

11 To drag the field of view and aim the BTCamera, click and hold the beam wireframe.

Result: Once the BTCameras are correctly placed in WYSIWYG, you can record the positions and 
orientation reproduce in the physical Space. 
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BlackTrax visualization

Introduction

BlackTrax projects can be visualized within WYSIWYG, allowing fixture and Trackable interactions to be 
simulated in the WYSIWYG virtual Space. Fixtures or Trackables when selected in BlackTrax will be 
selected in the WYSIWYG. WYSIWYG, Tracking Tools and BlackTrax will need to each be open and 
running the project file for visualization to work correctly.

To visualize BlackTrax activity in WYSIWYG

1 In BlackTrax, have the BlackTrax project file open.

2 In WYSIWYG, in LIVE mode, go to the BlackTrax Pannel.

a. To open the BlackTrax Pannel if closed, from the Live menu, select BlackTrax Panel.

Result: The BlackTrax Panel will appear on the right side of the WYSIWYG window.

3 Mark the check box next to BTX Mode.

4 With BlackTrax running, click Connect.

Result: Activity in BlackTrax will now be visualized in WYSIWYG.

Using WYSIWYG to visualize data streams

WYSIWYG can visualize data from the Third Party Stream and DMX from Art-Net. This can be useful for 
debugging. Seeing fixtures and Trackables move in WYSIWYG based on the data can help determine if 
data is actually being transmitted. If there is no activity in WYSIWYG there could be problems in the 
BTSystem connections.

To visualize Third Party Stream activity in WYSIWYG

1 In WYSIWYG, in LIVE mode, go to the BlackTrax Pannel.

a. To open the BlackTrax Pannel if closed, from the Live menu, select BlackTrax Panel.

Result: The BlackTrax Panel will appear on the right side of the WYSIWYG window.

2 Mark the check box next to BTX Mode.

3 With BlackTrax running, click Connect.

4 Mark the check box next to Motion from Third Party Stream.

Result: Third Party Stream activity will now be visualized in WYSIWYG.

To visualize DMX from Art-Net activity in WYSIWYG

1 In WYSIWYG, in LIVE mode, go to the BlackTrax Pannel.

a. To open the BlackTrax Pannel if closed, from the Live menu, select BlackTrax Panel.

Result: The BlackTrax Panel will appear on the right side of the WYSIWYG window.

2 Mark the check box next to BTX Mode.

3 With BlackTrax running, click Connect.

4 Mark the check box next to DMX From Art-Net.
Result: DMX From Art-Net data will now be visualized in WYSIWYG.
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Using calibration data to adjust visualization in WYSIWYG

Once fixtures have their position calibrated in BlackTrax, this information can be used to improve 
visualization WYSIWYG. The position of fixtures in WYSIWYG will change to the calibration locations, 
creating a more accurate visualization. 

To use calibrated fixture positions in WYSIWYG

1 In BlackTrax, have the BlackTrax project file open.

2 In WYSIWYG, in LIVE mode, go to the BlackTrax Pannel.

a. To open the BlackTrax Pannel if closed, from the Live menu, select BlackTrax Panel.

Result: The BlackTrax Panel will appear on the right side of the WYSIWYG window.

3 Mark the check box next to BTX Mode.

4 Click Connect.

5 Mark the check box next to Calibrated Fixture Position.

Result: The position of fixtures in WYSIWYG will change to reflect the calibration data created in 
BlackTrax.

Using Stick Beams for fixtures in WYSIWYG

When visualizing in WYSIWYG, the beams of light fixtures can be changed to be represented as sticks. 
This can be useful for reducing clutter and confusion in the visualization and help to determine where 
fixtures are aiming and which fixtures are selected.

To use fixture stick beams in WYSIWYG

1 In BlackTrax, have the BlackTrax project file open.

2 In WYSIWYG, in LIVE mode, go to the BlackTrax Pannel.

a. To open the BlackTrax Pannel if closed, from the Live menu, select BlackTrax Panel.

Result: The BlackTrax Panel will appear on the right side of the WYSIWYG window.

3 Mark the check box next to BTX Mode.

4 Click Connect.

5 Mark the check box next to Show Beams With Stick.

Result: Fixture beams will be represented as sticks in WYSIWYG.
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Chapter  4

Tracking Tools for BlackTrax

This chapter provides information on how to use of Tracking Tools for BlackTrax. Tracking Tools is a 
separate program that controls the BTCameras used by the BTSystem.

In this chapter
Initial Set Up 42

Camera Calibration Mode  45

Tracking Mode 54
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Initial Set Up 

Introduction

Tracking Tools is used by to manage and control BTCameras. It is already installed on the BTServer and 
is ready for you to use. The following section will guide you though specific steps on how to use Tracking 
Tools to configure BTCameras to work in the Space and function with the BTSystem.

Using Tracking Tools to aim BTCameras

For tracking to occur, BTCameras have to be positioned around the perimeter of the Space looking in. 
Tracking occurs in an area when 2 or more BTCameras view the same area at the same time. A video 
feed of what BTCameras see is shown in Tracking Tools. Viewing the BTCamera feed in the visible 
spectrum, BTCamera positions can be evaluated.

Attention: The Space origin must be visible to at least 2 BTCamera for camera calibration to function 
correctly.

To view BlackTrax camera feed in visible spectrum
Note: BTCameras have to be connected with the BTSystem and Tracking Tools open for the 
BTCamera feed to be visible.

1 Go to the Cameras window, which by default is automatically open on the left side of the UI. 

a. To open this window if closed, go to the View menu and click Cameras.

2 In the Cameras window, select the camera group by clicking on the group name.

3 While the camera group is still selected, look below to the Property section for the camera group. 
Under the Camera Settings heading, set the Video Type field to MJPEG Mode from the drop down 
list.

4 Set the Filter Type Switch field to Visible Spectrum. 

Result: The video displayed from the BTCameras will appear as a gray scale image in the visible 
spectrum. 
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BTCamera Aim Assist

BTCameras possess an Aim Assist function to help with aiming BTCameras. When toggled on and 
Tracking Tools is running, the BTCamera will be selected and its live video feed prominently displayed in 
Tracking Tools. The camera image will be set to grayscale so the Space is visible, and exposure 
increased for a brighter image. Pressing the button again after aiming will return the BTCamera’s view 
to its previous settings.

To toggle Aim Assist on BTCamera 

With the BTCamera is connected to the BTSystem and Tracking Tools running, push the button on the 
right side of the BTCamera, above the Ethernet port.

Tracking Tools project file

A BlackTrax project requires specific information from Tracking Tools, (camera configuration, calibration 
and settings) that is unique to every BlackTrax project. This information is required every time 
BlackTrax runs. A Tracking Tools project file (.ttp) should be created to save and load all this needed 
information.

Save Project will save the open Tracking Tools project to the same file name and location under which it 
was previously saved. If you are saving the project for the first time, this command will perform as Save 
Project As.... Save Project As... is used to save the current project with a new file name and/or a new 
destination.

To save a Tracking Tools Project using Save Project

In Tracking Tools, go to the File menu and click Save Project.
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To save a Tracking Tools Project using Save Project As...

1 In Tracking Tools, go to the File menu and click Save Project As... .

Result: The Save As dialog box will appear.

2 In the Save As dialog box, navigate to location you want to save Tracking Tools file.

3 In the File Name field, type the name of the project.

4 Click Save.

To load a Tracking Tools Project

1 In Tracking Tools, go to the File menu and click Open... .

Result: The Open dialog box will appear.

2 In the Open dialog box, navigate to where the desired .ttp file is saved. Click on the file to select it.

3 Click Open.

Result: The .ttp file will load. Its information and settings will load into Tracking Tools.
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Camera Calibration Mode

BTCamera calibration settings

After BTCameras are placed and orientated with overlapping views around the Space, BlackTrax 
requires that all BTCameras are calibrated. Tracking Tools setting need to be configured for calibration 
to occur. 

To configure BlackTrax cameras for calibration

1 In Tracking Tools, open the Project Explorer window. From the View menu, click Project Explorer.

a. In the Project Explorer window, ensure all the BTCameras are in the same camera group and all 
cameras are connected. Group 1 should be the default group.

Note: If cameras are not visible in the Project Explorer window, check connections to see if any 
cameras are disconnected from the system.

b. Close the Project Explorer window.

2 Go to the Cameras window, which by default is automatically open on the left side of the UI. 

Note: To open this window if closed, go to the View menu and click Cameras.

a. In the Cameras window, select the camera group by clicking on the group name.

b. While the camera group is still selected, look below to the Property section for the camera 
group. Under the Camera Settings heading, set the Video Type field to Precision Mode from 
the drop down list.

c. Set the Filter Type Switch field to Infrared Spectrum. 

3 Open the Reconstruction Properties window. From the View menu and click Reconstruction 
Properties.

a. In the Reconstruction Properties window, in the Point Cloud section, Enable Point Cloud 
Reconstruction by clicking and checking the check box.

b. Under the 2D Object Filter heading set the Filter Type to None from the drop down list.

c. Close the Reconstruction Properties window.

4 Open the Application Setting window. From the Edit menu, click Tracking Tools Settings....
a. In the Application Setting window, in the Options tab, under the Application Options heading, 

set the Active Marker Labeling field to False.

b. In the Display tab, under the 2D Display Options heading, set the Camera Reticle field to True.

c. Under the 3D Options heading, set the Show Marker Label field to True.

d. Close the Application Setting window.
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5 Open the Synchronization window. From the Tools menu, click Synchronization.

a. Under the Synchronization heading, from the drop down list select Custom Synchronization.

b. Under the Sync Input heading, set the Source field to Reserved.

c. Set the Synchronization offset to 5000.

d. Click Apply.

e. Close the Synchronization window.

6 Open the Streaming Properties window. From the View menu click Streaming Pane.

a. In the Streaming Properties window, under the OptiTrack Streaming Engine heading, click to 
check the Broadcast Frame Data check box.

b. Under the Network Interface Section heading, set the Local Interface field to Local Loopback.

c. Save the changes to the project file. Go to the File menu and click Save Project.

Unique camera configuration setting

Because every Space is different, there are certain BTCamera setting that will be unique. This section 
will provide guidelines on what certain Tracking Tools setting should be, to create an accurate tracking 
environment.

Space Boundaries
In Tracking Tools you must create a boundary around the Space. The boundary will tell the system to 
ignore infrared sources outside this boundary. It is important to properly define the boundaries as 
tracking will only occur inside these bounds.

Attention: The default boundaries are set at 6m from the origin on each axis in Tracking Tools. If your 
Space is larger then the default setting you will have to enter the boundaries of your Space.

To define boundaries you will have to measure how far the origin of the Space is from the intended 
boundary in the Space, on each axis (XYZ). The origin of the Space should be the same origin as the 
copy of the Space made in WYSIWYG.

Attention: In Tracking Tools the Z axis represents length and the Y axis represents height. In the rest 
of BlackTrax the Z axis represents height and the Y axis represents length.

Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking 
occurs below, enter a high enough value so tracking can occur. An example would be a Space whose 
venue is a stage with an apron and tracking occurs below in the audience.
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To set the tracking boundary of the Space 

1 Open the Reconstruction Properties window. From the View menu click Reconstruction 
Properties.

2 In the Reconstruction Properties window, in the Point Cloud section, under the 2D Object Filter 
heading set the Filter Type to None from the drop down list.

3 Under the Reconstruction Bound heading, set the Minimum X (meters) field to the distance from the 
origin of the Space to the intended boundary on the negative (-) X axis (width). Represent the 
number as a negative (-).

4 Set the Maximum X (meters) field to the distance from the origin of the Space to the intended 
boundary on the positive (+) X axis (width). Represent the number as a positive (+) number. 

5 Set the Minimum Y (meters) field to the distance from the origin of the Space to the intended 
boundary on the negative (-) Y axis (height). Represent the number as a negative (-).

6 Set the Maximum Y (meters) field to the distance from the origin of the Space to the intended 
boundary on the positive (+) Y axis (height). Represent the number as a positive (+). 

7 Set the Minimum Z (meters) field to the distance from the origin of the Space to the intended 
boundary on the negative (-) Z axis (length). Represent the number as a negative (-). 

8 Set the Maximum Z (meters) field to the distance from the origin of the Space to the intended 
boundary on the positive (+) Z axis (length). Represent the number as a positive (+). 

9 Close the Reconstruction Properties window.

10 Save the changes to the project file. Go to the File menu and click Save Project.
Result: The boundary in your Space will be defined, tracking is only possible inside this boundary. 

To view the tracking boundary of the Space

1 Open the Reconstruction Properties window. From the View menu and click Reconstruction 
Properties.

2 In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction 
Bounds heading set the Visible Bounds field to True.
Result: In Perspective View window the boundary of the space will appear as a transparent shape 
when zoomed out.

3 Save the changes to the project file. Go to the File menu and click Save Project.

BTCamera beam length
Tracking tools has a maximum and a minimum beam length for all BTCameras. Infrared sources, such 
as a LED Stringer of a BTBeacon, that are outside this range will not be acknowledged by the system. 
Depending on the size of the Space the beam length values will have to change in Tracking Tools.

Attention: The default BTCamera beam range is set at minimum 0.2m, maximum 10m. The Maximum 
distance should be the largest distance between a BTCamera and the furthest visible tracking boundary. 
The minimum distance should be the shortest distance between a BTCamera and the closest visible 
tracking boundary. 
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To set BlackTrax BTCamera beam length

1 Open the Reconstruction Properties window. From the View menu and click Reconstruction 
Properties.

2 In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction 
Bounds heading set the Minimum Ray Length field to the desired value.

3 Set the Maximum Ray Length field to the desired value.
4 Save the changes to the project file. Go to the File menu and click Save Project.

Result: The beam length of cameras will be set and cameras will only view within this range.

Masking infrared interference during calibration

Masking is a function in Tracking Tools where an area of the BTCamera’s vision is blocked out (masked). 
This will tell the system to ignore the masked section when looking for infrared sources. This is used 
primarily to block out infrared interference that can confuse the system during camera calibration.

Excessive masking may limit a BTCamera field of view, as a masked area makes a BTCamera blind to 
tracking in that area. It may be more beneficial to reposition BTCameras to create different fields of 
view, rather then masking in extreme cases of infrared interference.

Attention: Masking is done automatically in Tracking Tools as part of camera calibration. The following 
instructions are only needed if you intended to mask a BTCamera view from interference manually.

To manually mask a camera view

1 In Tracking Tools, open the Camera View window. From the View menu, click Camera Preview.

2 At the top of the Camera View window is a toolbar. Enable 2D Multi Camera View by clicking the 2D 
Multi Camera View icon  in the toolbar.

Result: The Camera View window will display a 2D view of what each connected camera sees. 
Infrared sources will appear as white.

3 In the Camera View toolbar, select either rectangular blocking by clicking the Rectangular Blocking 
icon , or circular blocking by clicking the Circular Blocking icon  in the toolbar.

4 Click inside the 2D view window of a camera. Mask the infrared interference areas by clicking in 
one corner of the interference, and while holding the mouse button down, dragging the mask to 
the desired size.

Result: The infrared interference (white) area will be covered in a mask (red).

5 Repeat Step 4 for each instance of camera infrared interference.

a. To have masks only cover infrared sources, in the Camera View toolbar, click the Block All Visible 
Markers icon .

Result: Any infrared interference in a masked portion of a camera 2D view will stay masked. Areas 
that are covered by a mask but show no interference will be unmasked.

6 Save the changes to the project file. Go to the File menu and click Save Project.

To clear all masks from a camera view

1 In Tracking Tools, open the Camera View window. From the View menu, click Camera Preview.

2 At the top of the Camera View window is a toolbar. Enable 2D Multi Camera View by clicking the 2D 
Multi Camera View icon  in the toolbar.

Result: The Camera View window will display a 2D view of what each connected camera sees. 
Infrared sources will appear as white.

3 In the Camera View toolbar, click the Clear Blocking icon .

Result: All masking will be cleared from the Camera View window.
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Camera calibration

When BTCameras are initially placed in the Space, or if they are moved after set up, or bumped 
accidentally, calibration of BTCameras is required. Camera calibration enables the system to determine 
where the BTCameras are in relation to each other using the calibration wand, and where they are in 
relation to the floor using the ground plane. Proper calibration is very important, as incorrect 
calibrations will give incorrect position data and negatively influence BlackTrax system accuracy.

Attention: Anytime a BTCamera is moved or bumped, camera calibration will have to be performed and 
saved to the project file.

To calibrate BTCameras with the calibration wand 

1 In Tracking Tools, go to the 3 Mark Calibration window, which by default is automatically open on 
the right side of the UI. 

Note: To open this window if closed, go to the Tools menu, click 3-Marker Calibration.

a. In the 3-Mark Calibration window, in the Calibration tab, under the 3-Marker Calibration heading, 
click Block Visible 

Result: All visible infrared sources all camera’s field of vision will be blocked

b. Under the Solver Option heading, set Quality field to Medium from the drop down menu.

c. Set the OptiWand heading to Custom.

d. Under the OptiWand heading, set the Wand Length (mm) field to 990.

e. Set the Center Distance (mm) field to 330.

f. Under the Data Acquisition heading, set the Sample Speed field to 50%.

g. Set the Minimum Camera Coverage field to 50%.

h. Under the Wand Acquisition heading, set the Minimum Object Roundness field to 0.3.

2 Click Start Wanding.

Result: BlackTrax cameras will now record calibration wand data within the Space.

a. In the Space, plug the power source into the calibration wand.

b. Wand the Space by moving the calibration wand slowly across the Space. Try to move the 
wand up and down and back and forth while you move, to create different data points. Ensure 
the calibration wand LEDs are not covered or being blocked from BTCamera view.

Tip: A recommended path to take is to start at the Space origin, and then to do a circle around the 
inside of the Space perimeter.

3 In Tracking Tools, open the Camera View window. From the View menus, click Camera Preview.

a. Look at the 2D Multi Camera window. Examine each BTCamera’s recording of the calibration 
wand. Wand samples are represented as colored lines by each camera. Each camera view 
should have samples recorded. 

Attention: If a BTCamera will not record samples while wanding, even though the wand is visible, 
consult the 2D Multi Camera View. See if other BTCameras are detecting the wand. If the wand does 
not appear on any other BTCameras, the area will not calibrate due to lack of coverage. If the wand 
shows up on at least two other BTCameras, continue wanding, but adjust the path and angle of the 
wand to give the BTCameras different views. If a section of the intended Space will not record 
samples after all of the steps above, cancel the calibration. Reposition the cameras to obtain better 
field of view overlap for that area.

b. View the 3-Marker Calibration window, under the Calibration Engine heading in the Samples 
Window. Here feedback will display on the number of times the calibration wand was viewed 
from each BTCamera. The window will give a rating which defines whether sufficient samples 
were recorded for low, medium, high, or very high quality calibration. 
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Note: The average number of samples per BTCamera should be about 500-1000.

Note: Be careful to not create too many samples. If BTCamera samples are too large camera 
calibration will take significantly longer

4 Click Calculate.

Result: Under the Calibration Engine heading, the Samples Window will change into the Solver 
Window. Displayed at the top of the solver window is the current stage the solver is in, followed 
by the overall result rating and the overall quality the engine is attempting to achieve. 

The calibration engine will attempt to solve for “Medium” calibration quality. This will let the 
BTCameras determine their general position in the Space quickly.

The calculation is run automatically. The first phase is “Refine Initial Solution”, then “Global 
Optimization: Initial” phase, and last is “Global Optimization: Final” phase. Each phase will solve 
the calibration of the system in greater detail, and the system will move from to the next 
automatically. Once the solver reaches the final optimization phase, it will continue to refine the 
solution until the user applies the results to the BTCameras. 

The solver window will display a quality rating for all BTCameras as well as the global average and 
the wand average. Valid quality ratings are (in order from worst to best rating): Poor < Fair < Good 
< Great < Excellent < Exceptional. 

Note: In the Perspective View window you can see a visualization of the wand sample collected 
being used in the calculation. The BTCameras will also move in the Perspective View Space to match 
their position in the physical Space as they learn where they are.

Note: The mean error is what determines the quality rating. The lower the mean error the better the 
quality rating. After a time, the system will have diminishing returns with the calibration data and 
the ratings will not improve quickly beyond that point. You can tell if you have reached diminished 
returns if all the MeanError column numbers have frozen after a time and will not go lower.

Note: If a BTCamera’s mean error is disproportionately higher then the rest, that is an indication 
of poor wand samples collected for that BTCamera during calibration. It is recommended that you 
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restart the wand calibration process. Make sure the BTCamera and at least one other have vision of 
the calibration wand during wanding.

5 Once the rating for each BTCamera reaches “Excellent” or greater, and the Overall Results quality 
rating reaches “Excellent” or greater, click Apply Results. 

Result: The Calibration Results Reports window will open. Calibration results and addition options are 
available.

6 In the Calibration Results Reports window click Apply and Refine.

Result: The desired calibration quality will increase from “Medium” to “Very High”. A “Very High” 
calibration is used to determine BTCamera positions to a greater degree. The calibration engine will 
attempt to further refine data to reach an “Excellent” or greater rating for all cameras on “Very 
High” calibration. It is necessary to Apply and Refine calibration results at least once during 
calibration.

The calibration results for each BTCamera will initially downgrade when the calibration quality is 
changed to “Very High”. The standards for a “Very High” calibration are greater then that of a 
“Medium” calibration. 

7 Once the quality rating reaches “Excellent” for each BTCamera and for the Overall Results, click 
Apply Results.

8 In the Calibration Results Reports window click Apply.

Result: BTCameras will know their position in the Space in relation to each other. This can be 
viewed as cameras arrange themselves in the Perspective View window in Tracking Tools. 

9 Save the changes to the project file. Go to the File menu and click Save Project.

Known calibration issues
 Issue: When Calibration Engine is calculating, calibration might lock up before it has reached 

diminishing returns or desired calibration rating. 
Solution: This could be a calculation error the system is stuck on. A possible solution is to click 
Apply Results, then in the Calibration Results Reports window click Apply and Refine. This will give the 
Calibration Engine more data to work with and it might be able to move past the error.

 Issue: After trying to calibrate multiple times the Calibration Engine will not give a Global 
“Excellent” rating.
Solution 1: The data samples taken from wanding may be bad and could be an issue. Ensure the 
Space is properly masked from infrared interference and rewand.
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To calibrate BTCameras with the ground plane

After the BTCameras are calibrated with the calibration wand, it is necessary to calibrate with the 
ground plane. This step will inform the System where the floor is and where the BTCameras are in 
relation to the floor. It will also inform the system the direction of the axis.

Attention: The origin of the Space must be visible to a minimum of 2 BTCameras to calibrate correctly.

1 In the Space, unfold and lock the ground plane into an L shape, ensuring the arms are at a 90° 
angle.

2 Plug in the power source to an outlet and connect the power source to the ground plane.

3 Move the center marker or the ground plane over the Origin of the Space. Adjust the feet of the 
ground plane to align the ground plane level with the floor. You can see if the ground plane is level 
with the built in level on the ground plane arms.

Attention: The origin of the coordinate plane of the tracking space must be the same as the origin 
of the virtual representation of the tracking space as made in WYSIWYG. Ensure this matches the 
(0,0,0) position in the WYSIWYG file. If the virtual representation and actual tracking area do not 
share the same origin, positional data and fixture tracking will be incorrect.

4 Point the long arm of the ground plane to the +Y axis (what is called the +Z axis in Tracking Tools), 
the short arm to the +X axis.

5 In Tracking Tools, in the 3-Marker Calibration window, in the Ground Plane tab, enter 90mm in 
the Vertical Offset (mm) field.

Attention: If the ground plane is not placed on the surface of the origin, such as on a tripod, 
measure the distance between the X-Z plane and the center of the ground plane markers. Enter in 
this value in the Vertical Offset (mm) field instead.

6 To apply ground calibration, click Set Ground Plane.

Result: The BTCameras will know their position in relation to the ground and adjust accordingly in 
Camera View window in Tracking Tools.

7 Save the changes to the project file. Go to the File menu and click Save Project.
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Tracking Mode

After BTCameras are calibrated, minor adjustments need to be entered in Tracking Tools for the system 
to switch from camera calibration to tracking mode. These setting enable fixture tracking to occur. Once 
tracking mode is configured, no changes to the Tracking Tools project need to be made unless cameras 
were moved or bumped since camera calibration.

To configure BTCameras for normal tracking

1 In Tracking Tools, open the Cameras window. From the View menu click Cameras.

2 In the Cameras window, select the BlackTrax camera group by clicking on the camera group name.

a. While the camera group is still selected, look below to the Property section for the camera 
group. Under the Capture Volume Visualization heading, set the Volume Resolution field to 100.

b. Set the Opacity field to 20%.

c. Set the Camera Overlap field to 2.

Result: A 3D image of the Space will be visible in the Perspective View window

3 Open the Applications Setting window. From the Edit menu, click Tracking Tools Settings.

a. In the Applications Setting window, under the Applications Options heading, set the Active 
Marker Labeling field to True.

Result: BTCameras will only track infrared sources with identifying pulses, such as the LED of a 
Pulsers connected to BTBeacons.

4 Save the changes to the project file. Go to the File menu and click Save Project.
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Chapter  5

BlackTrax GUI

This chapter provides information on the BlackTrax user interface and various functions of BlackTrax.

In this chapter
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Before Using BlackTrax

Attention: Before running the BlackTrax GUI, ensure you have completed the following mandatory 
steps to ensure a successful BlackTrax experience: 

 Set up the BTSystem in the Space - The BTSystem needs to be physically installed in the Space. 
See BlackTrax System Overview for information on how to set up the BTSystem.

 Create a .btx file in WYSIWYG - A .btx file provides BlackTrax with information on Trackables, 
Fixtures and Space dimensions. See WYSIWYG for BlackTrax for information on how to create a 
.btx file.

 Configure and Calibrate BTCameras using Tracking Tools - Tracking Tools needs to be used 
to configure BTCameras and inform the BTSystem how to track and how to communicate position 
information with the other components. See Tracking Tools for BlackTrax for information on how to 
configure and calibrate BTCameras. 
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BlackTrax User Interface

Introduction

When BlackTrax launches, it will bring you by default to the Project page. Before the Project page and 
the other pages of BlackTrax are explained, we will first familiarize you with the various parts of the 
user interface. 

Layout of BlackTrax GUI

The functions of BlackTrax are divided into several simple pages. At the top of the window is the Page 
Bar which allows for navigation to the pages when clicked. The pages of BlackTrax are:

 Control Panel: The Control Panel page is where you will control a BlackTrax project. You will have 
control over the ability to toggle Following by and Calibration Mode On/Off. You can manually 
switch between chapters or enable chapter control from a console. You can connect or disconnect 
BlackTrax modules to the system as well as view current BTBeacon assignments and data. Only 
information that is saved and applied to the project is displayed here.

 Project: The Project page is the starting point for any BlackTrax project. From here you will import 
a WYSIWYG (.btx) file to use as a foundation for your BlackTrax project (.btprj) file. Here you can 
open, save and modify existing BlackTrax projects as well as update a .btprj file with additional 
information from an updated .btx file.

 Beacon Assignment: The Beacon Assignment page is where information on all active BTBeacons 
is shown. Available Trackables are also visible on this page for BTBeacons to be assigned to. 

 Chapters: The Chapter page is where you will assign fixtures to follow Trackables. The beam size 
of fixtures following can also be set. An single instance of fixture relationships is called a chapter. 
Chapters can be edited, saved and managed in this page.

 Trackables : The Trackables page is where you can assign attributes to Trackables. Trackables are 
anything you want to be tracked that has a BTBeacon assigned to it. Attributes of Trackables are 
the functions of the assigned BTBeacon buttons, the following offset of the BTBeacon’s Pulser, and 
the creation of Sub-Trackables.

 Fixture Calibration: The Fixture Calibration page allows for correction and adjustments of 
approved movable fixture connected to BlackTrax, ensuring precision when following Trackables. 
Features of fixtures that can be calibrated are the pan and tilt settings. The calibrations profiles 
created can then be exported and imported for use as needed.

 System: The System page displays BlackTrax system data in addition to allowing further 
customization of your BlackTrax experience. A detailed system log, a list of network outputs, and a 
complete list of all fixtures and BTBeacons including attributes are available for viewing in this 
page. 
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Status Bar

Along the bottom of the screen there is a status bar that displays important system information at a 
glance. The following information is available for view:

I. Following Icon: Signifies if fixtures are following Trackables.

II. Calibration Icon: Signifies if calibration mode is active.

III. Chapter Control: Signifies if chapters are in manual or Art-Net control. 

IV. Current Chapter: Displays the chapter currently active.

V. Units: Unit of measurement used in the project.

 Change Buttons

At the bottom right corner of each page are the change project buttons. These buttons are used to 
affect changes made to a BlackTrax project.

 Discard Changes - Will rollback changes made in the BlackTrax project to the last savepoint created. 
If no savepoint was created, the project will revert to as it was when opened.

 Apply Changes - Any changes made to the BlackTrax project will be applied and usable by the 
BTSystem. A temporary savepoint for any changed made to the BlackTrax project will also be 
created. The savepoint will last until the BlackTrax project is closed.

 Verify Changes - Will check the project for errors since the last changes were applied. Will verify if 
any changes made will break the project.
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Project Page

The Project page is where a BlackTrax project starts. From this page a WYSIWYG (.btx) file is imported 
to create a BlackTrax project (btprj) file . Other features that are available is the ability to save, load, 
and update projects with new information.

Layout of Project Page
I. Create Project - Imports a .btx file to create a .btprj file.

II. Open Project - Opens a previously saved .btprj file.

III. Update BT Project - Updates the current .btprj with information from an updated .btx file. 

IV. Close Project- Closes the current .btprj file.

V. Save Project - Saves the current .btprj file.

VI. Save Project As - Makes a copy of the current .btprj file in a different folder and/or makes a copy with 
a different name.

Starting a BlackTrax project 

Create Project will import information from a previously created WYSIWYG (.btx) file to create a BlackTrax 
project (.btprj) file. A .btprj file is the accumulation of all the information gathered from a .btx file, plus 
all the settings and tracking information created in BlackTrax. 

If another project is currently opened, you will be prompted to save changes to that project before a 
new project is created. Only one BlackTrax project may be open at a time.

To create a .btprj file

1 Click Create Project.

Result: The Create Project dialog window will appear.

2 In the Create Project window, next to the BTX File field, click “...”.

Result: The Browse window will open.

3 In the Browse window, navigate to the .btx file location and select the file.

4 Click Open.

5 Next to the Project File field, click “...”.

Result: The Browse window will open.

6 In the Browse window, navigate to where you want to save the BlackTrax project file (.btprj).

7 In the Name field, enter the name of the .btprj file.

8 Click Save

9 Click Ok.

Result: Information from the .btx file (e.g. fixtures, Trackables, Space dimensions) will be loaded 
into a new BlackTrax project. The project will be named and saved as directed.

Opening BlackTrax projects

Open Project will open a previously created BlackTrax project. If another project is currently opened, you 
will be prompted to save changes to that project before a new project is opened.
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To open a BlackTrax project

1 Click Open Projects.

Result: The Browse window will open.

2 The Browse window, navigate to the .btprj file location and select the file.

3 Click Open.

Closing BlackTrax projects

Close Project will exit out of the currently open BlackTrax project while keeping the GUI open. Close Project 
will not save the BlackTrax project.

To close a BlackTrax project

1 Click Close.

2 A dialog box will appear asking if you really want to close the project. To close the project click Yes.

Result: The .btprj file will close.

Updating BTX Projects

If a WYSIWYG project file has been edited, Update BTX Projects will update the BlackTrax project that is 
based on the WYSIWYG project with the new information.

To update a BlackTrax project with new information from WYSIWYG

1 Click Update BTX Projects.

Result: The Browse window will open.

2 In the Browse window, navigate to the edited .btx file location, and select the file.

3 Click Open.

Result: Information from the .btx file (e.g. fixtures, trackables, Space dimensions) will be loaded 
into BlackTrax. 

Saving BlackTrax projects

BlackTrax projects are saved as a .btprj file. Save Project will save the open BlackTrax project to the same 
file name and location under which it was previously saved. If you are saving the project for the first 
time, this command will perform as Save Project As. Save Project As is used to save the current project with 
a new file name and/or a new destination.

To save a BlackTrax project using Save Project

To save the current project, click Save Project.

To save a BlackTrax project using Save Project As

1 Click Save Project As.

2 The Browse dialog box will appear. 

3 In the Browse dialog box, navigate to location you want to save the file.

4 In the File Name field, type the desired name of the file.

5 To save the file, in the dialog box click Save. 
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Trackables Page

Introduction

The Trackables page is where information on all Trackables in the project is shown, and where 
Trackables settings can be edited. Trackable setting are linked to the Trackable itself. Any BTBeacon 
assigned to the Trackable will inherit the Trackable’s settings, and function as directed.

Layout of Trackable Page
I. Trackables - List of all Trackables in the project.

1. Name - Name of the Trackable.

2. Wysiwyg Frame - Name of the Frame assigned to the Trackble in WYSIWYG.

3. Beacon Assign - Indicates if a BTBeacon is assigned to a Trackable.

4. LED Tracking - Indicates if Sub-Trackables are enabled in the Trackable.

II. Trackable Setup - Customization options of a Trackable.

1. Name - Name of Trackable as it will be displayed in BlackTrax.

2. LEDs - Method of tracking BTBeacon assigned to the Trackable.

3. Beacon Centroid Offset - Section to configure how off-center from an assigned BTBeacon Pulser 
LED the system should follow.

a. X - The offset value on the X axis.

b. Y - The offset value on the Y axis.

c. Z - The offset value on the Z axis.

4. 3 Trackable LEDs - Section to configure Sub-Trackables parts of a Trackable. 

a. Active - Check box to toggle a Sub-Trackable On/Off.

b. Sub-ID - Identifying number of the Sub-Trackable.

c. Sub-Trackable Name - Name of the Sub-Trackable.

d. LED Assignment - A drop-down list of which port on the BTBeacon will relay 
position data for the Sub-Trackable.

5. IMU - Enables/disables use of the BTBeacon IMU.

6. Orientation - Enables/disables the use of orientation data in Trackable positions.

III. Third Party Output Settings - Drop-down list for selecting third party output setting.

Configurable Trackable Functions

The Trackable Setup section is where the settings of Trackables can be edited. A BTBeacon assigned to 
the Trackable will function according to these settings.

To edit a Trackable name

1 In the Trackables section, select the Trackable you want to edit. 

2 In the Trackable Setup section, in the Name field, enter the name of the Trackable.

3 For the changes to take effect, click Apply Changes.
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To set the IMU configuration of an assigned BTBeacon
A BTBeacon can have their IMU enabled or disabled during tracking when assigned to a Trackable. If the 
IMU is disabled, the Trackable’s position is only based on where BTCameras can see the assigned 
BTBeacon’s Pulser LED.

Attention: Disabling the IMU will disable the backup tracking that the IMU provides if Pulser LEDs 
become covered.

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, from the IMU drop-down list select the desired IMU configuration. 

3 For the changes to take effect, click Apply Changes.

LED Tracking Configurations

There are two methods for tracking of Pulser LEDs to be configured; Centroid Tracking and Individual 
LED Tracking.

Centroid Tracking

Centroid Tracking is used when you want a track a single point on a Trackable. One or more Pulser can 
be connected to a BTBeacon assigned to the Trackable in this mode. If a single Pulser is used, the 
Pulser’s LED pulses its position data to the BTSystem. The BTSystem uses this position as the focal point 
of the Trackable.

When multiple Pulsers are attached to a BTBeacon, each Pulser’s LED broadcasts its individual position 
to the system. BlackTrax determines the center between all of the Pulser LEDs and sets that as the focal 
point of the Trackable.

Note: Centroid Tracking supports Beacon Centroid Offsets.

Individual LED Tracking
Individual LED Tracking is used when a Trackable has multiple points you want to track independently. 
An assigned BTBeacon has multiple Pulsers attached, each broadcasting its individual position to the 
BTSystem. The Trackable is separated into Sub-Trackables, with an single Pulser and its position 
assigned to a single Sub-Trackable. Sub-Trackables act exactly as Trackables; they can have fixtures 
assigned and be tracked independently using their own positional data.

To set the LED configuration of an assigned BTBeacon

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, from the LEDs drop-down list select the LED configuration.

3 For the changes to take effect, click Apply Changes.

Configuring centroid offsets

By default the focal point of a Trackable is the center of a connected Pulser LED. You may find that 
where the Pulser LED is positioned on a Trackable is not where you want the focal point of a Trackable to 
be. The focal point can be offset relative to the position of the Pulser LED. You can offset the position on 
the X,Y,Z axes. This ensures that BlackTrax is always following how you intend it to. 

Attention: Ensure LEDs is set to Centroid Tracking to use the Beacon Centroid Offsets section.

To configure the BTBeacon centroid offset

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, go to the Beacon Centroid Offset sub-section.
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3 Enter the desired off-set values in the appropriate fields.

4 For the changes to take effect, click Apply Changes.

Configuring Sub-Trackables

A Sub-Trackable is created when there is a Trackable that has multiple areas you want to track 
separately, using a single BTBeacon and multiple Pulsers. Sub-Trackables share the same rotational 
data generated by the parent BTBeacon, but have independent positional data from their assigned 
Pulser.

Note: A maximum of 3 Sub-Trackables can be created for each Trackable.

Attention: Ensure LEDs is set to Individual LED Tracking to use the 3 Trackable LEDs section.

To toggle a Sub-Trackable On/Off

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, go to the 3 Trackable LEDs sub-section.

3 In the Active column, in the Sub-ID row of the Sub-Trackable, click the check box to toggle the Sub-
Trackable. 

Note: If the check box is marked, the Sub-Trackable will be active. If the box is blank, the Sub-
Trackable will be disabled.

4 For the changes to take effect, click Apply Changes.

To assign an LED port to a Sub-Trackable

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, go to the 3 Trackable LEDs sub-section. 

3 In the LED Assignment column, in the Sub-ID row of the Sub-Trackable, select the LED port from the 
drop-down list.

Note: If the selected LED port was in use by another Sub-Trackable, that Sub-Trackable’s assigned 
port will change to None. 

4 For the changes to take effect, click Apply Changes.

Result: The Sub-Trackable’s position will now be associated with the Pulser that is in the assigned 
LED port of an assigned BTBeacon. 

To name a Sub-Trackable

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, go to the 3 Trackable LEDs sub-section. 

3 In the Trackable Name column, in the Sub-ID row of the Sub-Trackable, click in the field and enter 
the name of the Sub-Trackable in the field.

4 For the changes to take effect, click Apply Changes.

Configuring the IMU of Trackables

By default, when a BTBeacon is assigned to a Trackable, the BTBeacon’s IMU will generate orientation 
data on the Trackable’s position. The IMU also generates positional data to be used as a safeguard 
against tracking disruption. 
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To toggle the generation of IMU positional data 

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, from the IMU drop-down list select the IMU setting.

3 For the changes to take effect, click Apply Changes.

To toggle the generation of IMU orientational data 

1 In the Trackables section, select the Trackable you want to configure.

2 In the Trackable Setup section, from the Orientation drop-down list select the orientation setting.

3 For the changes to take effect, click Apply Changes.

Configuring third party output of Trackables

By default, the position information of all Trackables is sent to third parties as both Euler and 
Quaternion. BlackTrax can be configured to send information as Euler and Quaternion or only send data 
as Euler.

To toggle third party output

1 In the Trackables section, select the Trackable you want to configure.

2 In the Third Party Output Settings section, from the drop-down list select the desired output setting.

3 For the changes to take effect, click Apply Changes.
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Chapters Page

Introduction 

The Chapters page is where moving fixtures are assigned to follow the position of Trackables. A chapter 
is saved information on which Trackables are to be tracked and which fixtures are to follow them at a 
specific instance. BlackTrax allows for up to 48 fixtures following, and up to 12 BTBeacons active in a 
chapter. You can create as many chapters as you need and can switch between them freely, enabling 
infinite combinations of fixtures and Trackables. 

Layout of Chapter page
I. Chapters - List of created chapters and chapter management tools.

1. Name - Name of the chapter.

2. Description - A short description or note of the chapter.

3. Copy Chapter - Creates a copy of a selected chapter.

4. Plus - Creates a new blank chapter.

5. Minus - Deletes currently selected chapter.

6. Up Arrow - Move selected chapter up one position in the chapter list.

7. Down Arrow - Move selected chapter down one position in the chapter list.

II. Fixture Properties - Configuration options for fixtures.

1. Fixture - Name of selected fixture.

2. Beam Control - Section for controlling the footprint of a beam.

a. Enable Iris Control - Control the beam footprint using the iris of the fixture.

b. Enable Zoom Control - Control the beam footprint using the zoom of the fixture.

c. Beam Size - Size of the beam footprint.

d. Distance Range - The range of distance from a fixture a Trackable can be and 
maintain the beam size.

3. LED Control - Fixtures assignment to Sub-Trackables.

III. Project Information - Metadata on the BlackTrax project.

1. Show Name - Name of the BlackTrax project.

2. Author - Author of the BlackTrax project.

3. Description - Description about the BlackTrax project.

IV. Relationships - Trackables and assigned fixtures in a chapter.

1. Trackable Container – A representation of a Trackable used in the chapter.

a. Delete Icon - Deletes the Trackable from the chapter.

b. Maximize / Minimize - Toggles the size of the Trackable Container.

2. Fixture Icon - A representation of a fixture assigned to a Trackable in the chapter. 

a. Sub-Trackable ID - Identifier of which Sub-Trackable the fixture is assigned to.

3. Fixture settings filter - Drop-down list for enabling visual displays of fixture settings.

4. Delete All - Deletes every Trackable Container from the chapter. 

5. Minimize All - Minimizes every Trackable Container in the chapter.

6. Maximize All - Maximizes every Trackable Container in the chapter.

V. Library - A list of all Trackables and fixtures in the BlackTrax project.
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1. Trackables - List of all available Trackables.

a. Name - Name of the Trackable.

b. Patched - Patch status of Trackable.

c. Add - Adds selected Trackable to current chapter. 

d. Delete - Deletes selected Trackable from current chapter. 

e. Trackable patch filter - Drop-down list for filtering Trackables based on patch status.

2. Fixtures- List of all available fixtures. 

a. Name - Name of fixture.

b. Patch Info - Universe and channel information of fixture.

c. Assigned - Assignment status of fixture.

d. Assign - Adds selected fixture to the selected chapter. 

e. Unassign - Removes selected fixture from the selected chapter. 

f. Fixture assignment filter - Drop-down list for filtering fixtures based on assignment.

Managing chapters

The Chapters section is where chapters are created and edited. A chapter contains information on which 
Trackables are to be followed by assigned fixtures when the chapter is active.

To create a new chapter

1 In the Chapters tab, click the Plus button.

Result: A blank chapter will be created in the list below the currently selected chapter.

2 For the changes to take effect, click Apply Changes. 

To create a copy of an existing chapter
Copying a chapter will copy all aspects of the selected chapter, including fixture and Trackable 
relationships.

1 In the Chapters tab, select the chapter you want to copy.

2 Click the Copy Chapter button.

Result: A copy of the chapter will be created in the list below the currently selected chapter.

3 For the changes to take effect, click Apply Changes.

To delete a chapter

1 In the Chapters tab, select the chapter you want to delete.

2 Click the Minus button.

3 A dialog box will appear asking if you really want to delete the chapter. To confirm deletion, click 
Yes. 

4 For the changes to take effect, click Apply Changes. 

To move chapters in the chapter list

1 In the Chapters tab, select the chapter you want to move.

2 Move the chapter up or down by clicking the Up Arrow or Down Arrow button respectively.

3 For the changes to take effect, click Apply Changes. 
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To name a chapter 

1 In the Chapter tab, in the Name field of the chapter, double-click to enable editing. 

2 Enter the name of the chapter in the Name field.

3 For the changes to take effect, click Apply Changes. 

To write a description of a chapter 

1 In the Chapter tab, in the Description field of the chapter, double-click to enable editing.

2 Enter the chapter description in the Description field.

3 For the changes to take effect, click Apply Changes. 

Managing Trackables and fixtures in a chapter

The Relationship section displays which fixtures are assigned to which Trackables in the chapter. 
Available Trackable and fixtures are shown in the Library section. 

To add a Trackable to a chapter 
Adding a Trackable to a chapter tells the BTSystem that this Trackable has fixtures following it when the 
chapter is active.

1 In the Chapter tab, select a chapter you want to add a Trackable to.

2 View available Trackables by going to the Library section and clicking on the Trackables tab. 

3 In the Trackables tab, select the Trackable you want to add.

4 Click Add.

Result: A Trackable Container of the Trackable will appear in the Relationship section for the 
chapter.

Note: Trackables can also be added to a chapter by dragging and dropping a Trackable from the 
Trackable tab into the Relationship section.

5 For the changes to take effect, click Apply Changes. 

Note: To add a Sub-Trackable to a chapter, add the configured parent Trackable to the chapter.

To delete a Trackable from a chapter 

1 In the Chapter tab, select a chapter you want to delete a Trackable from.

2 View available Trackables by going to the Library section and clicking on the Trackables tab.

3 In the Trackables tab, select the Trackable you want to delete.

4 Click Delete.

5 For the changes to take effect, click Apply Changes. 

To remove all Trackables from a chapter 

1 In the Chapter tab, select a chapter you wish removes all Trackables from.

2 In the Relationship section of the chapter, click Delete All.

3 A dialog box will appear asking if you really want to delete all Trackables. To confirm deletion, click 
Yes.

4 For the changes to take effect, click Apply Changes.
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To assign a fixture to a Trackable
When a fixture is assigned to a Trackable, the BTSystem will instruct the fixture to follow the Trackable. 
Fixtures will only follow an assigned Trackable in the chapter they are assigned, and only when that 
chapter is active.

1 In the Chapter tab, select a chapter that has a Trackable you want to assign a fixture to.

2 In the Relationship section, select the Trackable Container of the Trackable.

3 View available fixtures by going to the Library section and clicking the Fixtures tab.

4 In the Fixture tab, select a fixture you want to assign to the Trackable.

5 Click Assign.

Result: A Fixture Box of the fixture will appear in the Trackable Container of the Trackable.

Note: Fixtures can also be assigned a Trackable by dragging fixtures from the Fixture tab and 
dropping them onto a Trackable Container.

6 For the changes to take effect, click Apply Changes.

To unassign a fixture from a Trackable

1 In the Chapter tab, select a chapter that has a Trackable you want to unassign a fixture from.

2 In the Relationship section, select the Trackable Container of the Trackable.

3 Go to the Library section and click the Fixtures tab.

4 In the Fixture tab, select the fixture you want to unassign from the Trackable.

5 Click Unassign.

Result: The Fixture Box will be removed from the Trackable Container.

Note: Fixtures can also be removed from Trackables by dragging fixtures from the Trackable Box 
to the Fixture tab.

6 For the changes to take effect, click Apply Changes.

Using filters in the Chapter page

The Chapter page allows you to add filters so that information on the page can be easily understood at 
a glance. This section will guide you on the various filters available.

Fixture settings filter - Drop-down list for enabling visual displays of fixture settings. When a filter is 
selected, the appropriate icons will appear on fixtures in the Relationship section that meet the criteria. 
The filters available are:

 Has setting - Will display if a fixture has any setting altered in the Fixture Settings section.
 Has beam setting - Will display if a fixture has any beam settings altered in the Fixture Settings 

section.
 Uses Iris - Will display if a fixture uses iris to change the beam size.
 Uses Zoom - Will display if a fixture uses zoom to change the beam size.
 Has LED setting - Will display if a fixture is assigned to a Sub-Trackable.

 Uses LED 1 - Will display if a fixture is assigned to a Sub-Trackable assigned to BTBeacon port 
1.

 Uses LED 2- Will display if a fixture is assigned to a Sub-Trackable assigned to BTBeacon port 
2.

 Uses LED 3- Will display if a fixture is assigned to a Sub-Trackable assigned to BTBeacon port 
3.

Trackable patch filter - Drop-down list for filtering Trackables based on patch status. When a filter is 
selected, Trackables that meet the criteria will be displayed in Trackables tab in the Library section.
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Fixture assignment filter - Drop-down list for filtering fixtures based on assignment. When a filter is 
selected, Fixtures that meet the criteria will be displayed in Fixtures tab in the Library section.

Managing fixture properties

The Fixture Properties section allows you to configure how fixtures interact with Trackables. The beam 
size of an assigned fixture on a Trackable and Sub-Trackable selection is controlled from here.

To control the beam size of a fixture
BlackTrax allows you to control the size of a fixture’s beam while it is following a Trackable. This is done 
using the iris or zoom features of a fixture. The beam setting of a fixture is linked to the chapter it was 
created. Fixtures can be in multiple chapters and have a different beam sizes in each chapter.

Note: If both zoom and iris control are enabled, the BTSystem will tell the fixture to first use zoom 
control to shape the beam size. If zoom is unable to create the intended beam size alone, then iris will 
be used as well.

1 In the Chapter tab, select the chapter the fixture is in.

2 In the Relationship section, in the Trackable Container of the Trackable the fixture is assigned to, 
click on the Fixture Icon of the fixture to select it.

3 With the Fixture Icon is selected, go to the Fixture Properties tab.

4 Under the Beam Control section, select the method of controlling the beam size by marking the 
check-box next to the desired method.

5 In the Beam Size field enter in the desired size of the beam.

Result: The Distance Range field will display the range the Trackable can be from the fixture and 
maintain the beam size.

6 For the changes to take effect, click Apply Changes.
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Assigning fixtures to Sub-Trackables

Each Sub-Trackable can be tracked individually by the BTSystem using separate Pulsers attached to the 
same BTBeacon. Sub-Trackables can have fixtures assigned and be followed by independently.

For details on configuring Sub-Trackables, see Individual LED Tracking.

To assign a fixture to a Sub-Trackable

1 In the Chapter tab, select a chapter that has a Trackable configured for Sub-Trackables.

2 In the Relationship section, select the Trackable Container of the Trackable.

3 Assign fixtures to the parent Trackable of the Sub-Trackable as normal.

Result: In the Relationship section, the assigned fixture will display a Sub-Trackable ID. The ID is 
which Sub-Trackable of the parent Trackable the fixture will follow. 

Note: The default Sub-Trackable setting is centroid tracking. Centroid tracking is when fixtures 
focus on the average position of all Pulsers attached to a BTBeacon.

4 In the Trackable Container of the Trackable the fixture is assigned to, click on the Fixture Icon of 
the fixture. 

5 While the Fixture Icon is selected, go to the Fixture Properties tab.

6 In the Fixture Properties tab, in the LED Control section, click the radio of a sub-Trackable you 
want the fixture assigned to.

Result: The Sub-Trackable ID will change to match your selection. The fixture will follow the selected 
Sub-Trackable.

7 For the changes to take effect, click Apply Changes.

Managing project information

The Project Information section is where descriptive metadata about the BlackTrax project is created, 
such as the show name, author, and description about the project. 

To edit project information

1 Go to the Project Information tab.

2 Click in a field to enable editing.

3 Enter in the project details as required.

4 For the changes to take effect, click Apply Changes.

Result: The project information will then be displayed in the Control Panel page, in the Project 
Information tab.
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Beacon Assignment Page

Introduction

The Beacon Assignment page is where the assignment of BTBeacons to Trackables is controlled. For the 
position of a Trackable to be known, a BTBeacon must first be assigned to the Trackable. The 
assignment will link the BTBeacon’s location with that of the Trackable. 

The X, Y, Z position of a Trackable is based on the position of the assigned BTBeacon’s Pulser LED in the 
Space. The Trackable’s orientation is based on the IMU within the BTBeacon. BlackTrax interprets the 
data based on the configuration of the Trackable as set in the Trackables page. 

BTBeacons broadcast data at all time when the BTBeacon is on, even if it is not assigned.

Attention: BTBeacons that are turned on count towards the limit of 12 BTBeacons allowed on at any 
one time. Even if the BTBeacon is not assigned, an active BTBeacon will count towards the system limit. 
If more then 12 BTBeacons are on at any time errors in tracking may occur. BTBeacons connected to the 
Charging Station do not transmit data and do not count towards the system limit.

Layout of Beacon Assignment page 
I. Available Beacons - Area for active BTBeacons currently not assigned.

1. Beacon Icon - Representation of an active BTBeacon.

a. Beacon Name - Name of BTBeacon.

b. Battery Icon - Percentage of power remaining in the BTBeacon.

c. X - The current X coordinate of the BTBeacon.

d. Y - The current Y coordinate of the BTBeacon.

e. Z - The current Z coordinate of the BTBeacon.

f. R - The current roll (rotation of X axis) value of the BTBeacon.

g. P - The current pitch (rotation of Y axis) value of the BTBeacon.

h. Y - The current yaw (rotation of Z axis) value of the BTBeacon.

i. A - Current status of the A button on the BTBeacon.

j. B - Current status of the B button on the BTBeacon.

k. Page Arrow (insert symbol) - Button to switch between data pages.

l. LED #- BTBeacon LED port number.

m. ID # - Unique identification pulse of connected Pulser.

n. Connectivity - Connection status of Pulser connected to the LED port.

o. XYZ - Position data of Pulsers in connected port.

II. Available Trackables - A visual of Trackables in the project. 

1. Trackable Container – A visual representation of a Trackable. 

a. Trackable Name - Name of Trackable.

Assigning BTBeacons to Trackables

To know the position of a Trackable, a BTBeacon is first assigned to the Trackable. This will associate the 
data of the BTBeacon with the Trackable. 
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To assign a BTBeacon to a Trackable 

1 Drag and drop the Beacon Icon of the BTBeacon from its location onto the Trackable Container of 
the Trackable.

2 For the changes to take effect, click Apply Changes.

Note: Assigning a BTBeacon to a Trackable that already has a BTBeacon assigned will cause the 
BTBeacons will switch places.

To unassign a BTBeacon from a Trackable

1 Drag and drop the Beacon Icon of the assigned BTBeacon into the Available Beacons section.

2 For the changes to take effect, click Apply Changes.
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Fixture Calibration Page

Introduction

The Fixture Calibration page is where the position of fixtures can be calibrated to ensure fixture tracking 
is precise and accurate.

To have a fixture follow an assigned Trackable, BlackTrax determines the position of the Trackable using 
the BTCameras and assigned BTBeacon. BlackTrax then references where the fixture is based on 
information collected from the WYSIWYG .btx file. Based on the Trackable and fixture positions, the 
BTSystem calculates the pan and tilt angles the fixture needs for it to aim at the Trackable. This 
information is then sent to the fixture.

If there are inconsistencies between the location of the fixture in the Space, and the virtual Space in 
WYSIWYG, tracking information BlackTrax creates will be inaccurate. 

Fixture calibration allows you to correct these inconsistencies and ensures fixture tracking is accurate. It 
is recommended that all fixtures be calibrated when they are first installed in the Space, and 
individually anytime a fixture is moved or bumped.

Attention: Discard Changes, Apply Changes and Verify Changes are disabled during Calibration Mode.

Attention: The Fixture Calibration page is locked until BlackTrax is set to Following and Calibration 
Mode.

Layout of Fixture Calibration page
I. Fixtures - Information on all fixtures in the BlackTrax project.

1. Name – Name of fixture.

2. Patch Info – DMX patch information of fixture.

3. Calibrated – Calibration status of fixture.

4. Algo ID – Algorithm type for fixture movement.

5. Latency (ms) – Latency value of the fixture.

6. Clear All – Removes calibration data from all fixtures.

7. Import Calibration – Load previously saved calibration data (.cal).

8. Export Calibration – Save current calibration data (.cal).

II. Calibration Results – Result of fixture calibration.

1. Original Data – Fixture values from WYSIWYG. 

2. Calibration Data – Created fixture values from calibration.

3. X - X axis position of fixture.

4. Y - Y axis position of fixture.

5. Z - Z axis position of fixture.

6. RX - Rotation of X axis of fixture.

7. RY - Rotation of Y axis of fixture.

8. RZ - Rotation of Z axis of fixture.

9. Pan - Pan value of fixture set to normal or inverted.

10. Tilt - Tilt value of fixture set to normal or inverted.

11. Use Original Fixture Position – BlackTrax uses the original fixture position.

12. Use Calibrated Fixture Position – BlackTrax uses the calibrated fixture position.
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III. Calibration Beacon – Information on BTBeacon used for calibration.

1. Calibration Beacon list – A drop-down list of all available BTBeacons.

2. Current Value – Current position data of selected BTBeacon.

IV. Measurement Points – Information on fixture measurement points sampled.

1. X – Measured X coordinate value of measurement point.

2. Y – Measured Y coordinate value of measurement point.

3. Z – Measured Z coordinate value of measurement point.

4. Pan Angle – Measured pan angle value of measurement point.

5. Tilt Angle – Measured tilt angle value of measurement point.

6. Calibration Error (Residual) – A value that indicates how accurate the pan and tilt angles of 
measurement points were based on all sampled measurement points. 

7. Freeze Beam /Unfreeze Beam – Freeze Beam will stop a BTBeacon from following a fixture, allowing a 
measurement point to be sampled. Unfreeze Beam will make a fixture continue following a 
BTBeacon. 

8. Collect Data Point – Will add a BTBeacon’s Pulser location as a measurement point.

9. Delete Point(s) – Will delete selected measurement points. 

10. Delete Fixture Calibration – Will delete all measurement points and created calibration data from a 
fixture.

11. Calibrate – Will create and apply calibration data to a fixture based on all collected measurement 
points.

Fixture Calibration

To turn on fixture calibration

1 In the Control Panel page, in the Tracking Control section, ensure Following is turned on.

a. To turn on fixture following, click Start Following.

Result: The BTSystem will be set to Following. Fixtures will follow assigned BTBeacons as 
directed by the selected chapter.

2 Click Enter Calibration.

Result: The BTSystem will be set to Calibration Mode. The features of the Fixture Calibration 
page are enabled.

To turn off fixture calibration

In the Control Panel page, in the Tracking Control section, click Exit Calibration.

Result: The BTSystem will exit Calibration Mode and enter Normal Mode. The features of the 
Fixture Calibration page are disabled.

Fixture latency 
BlackTrax always transmits the position of Trackables instantly in real time to fixtures. A fixture can only 
follow as fast as it is physically able to move. Slower fixtures may be lagged in following faster 
Trackables. A possible solution is to change the latency of the fixture. 

When a fixture’s latency is changed, BlackTrax will attempt to predict where the Trackable will be 
milliseconds in the future. The prediction is based on the previous movement and speed of the 
Trackable. BlackTrax will then tell the fixture to move ahead of the Trackable on the predicted path. 
Since the fixture is slow moving, the fixture it will be on top of the Trackable instead of ahead. 
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To edit a fixture’s latency

1 In the Fixtures section, in the Fixture List, select the desired fixture.

2 Double-click in Latency (ms) field of the fixture, enter in the latency value in the field.

Result: Changes take effect immediately after new values are entered. The fixture will operate at 
the set latency value.

Collecting calibration data

To calibrate a fixture, you will have to first collect measurement points for the fixture. Measurement 
Points are samples of fixture and BTBeacon data collect while a fixture is following a BTBeacon in the 
Space during calibration mode.

To create measurement points 

1 In BlackTrax, in the Fixture Calibration page, in the Fixture list select the fixture that needs to be 
calibrated.

Note: If calibration data has already been created for the fixture, the fixture will have to be set to 
Use Original Fixture Position.

a. To use original data, in the Calibration Results section, click the Use Original Fixture Position radio.

2 A BTBeacon will be used to calibrate the fixture. In the Calibration Beacon section, click the 
Calibration Beacon List to view a drop-down list of all available BTBeacons

3 Select the desired BTBeacon from the list.

Result: The selected fixture will follow the selected BTBeacon in the Space.

4 In the Space, take the chosen BTBeacon. Make sure that a single Pulser is connected to the 
BTBeacon.

5 Move the BTBeacon to a point within the Space. 

Result: The selected fixture should be following the BTBeacon in the Space.

Attention: The LED of the Pulser must be visible to 2 or more BTCameras simultaneously for 
tracking to occur. 

6 At a point in the Space with the fixture following the BTBeacon, in BlackTrack click Freeze Beam. 

Tip: Pushing the A button on the BTBeacon being tracked will activate Freeze Beam remotely.

Result: The fixture will stop in place.

Attention: You will not be able to use Freeze Beam if the BTBeacon is not tracked within the Space.

7 In the Space put the Pulser LED as close to the center of the fixture beam as possible. 

8 With the LED still in the center of the beam, in BlackTrack click Collect Data Point.

Tip: Pushing the B button on the BTBeacon being tracked will activate Collect Data Point remotely.

Result: BlackTrax will collect the data of BTBeacon and fixture as a measurement point when Add 
Point is clicked. It will add the data to the Measurement Points section. The fixture will unfreeze and 
continue following the BTBeacon. 

9 At different location in the Space, repeat steps 5 to 8 until you create a total of 8 measurement 
points.

Attention: The minimum number of measurement points needed for calibration is 8. 

Note: For best results the measurement points samples should be at different points in the Space, 
creating different pan and tilt angles. It is recommended to take measurement points in different 
areas of the Space and at different heights, creating the most variation. 
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To calibrate a fixture using collected measurement points
Once measurement points are created for a fixture, they can be used to create calibration data for the 
fixture and determine the fixtures calibrated position.

1 In the Fixture list select the fixture that needs to be calibrated.

2 In the Calibration Results section, click the Use Original Fixture Position radio.

3 In the Measurement Points section, have a minimum of 8 measurement points created.

4 Click Calibration.

Result: Calibration data is created from the measurement points and displayed in the Calibration 
Results section under the Calibration Data column. Use Calibrated Fixture Position becomes selected 
and the Calibration Data is automatically applied to the fixture. In the Fixtures section, the 
Calibrated field for the fixture will change to (green) to indicate that calibration data was created 
and that it is applied to the fixture. In the Measurement Point section, in the Calibration Error 
(Residual) column, residual values are create for each measurement point. 

Refining Calibration Data

After calibrating a fixture, Calibration Error (Residuals) for each measurement point will be 
calculated and shown in the Measurement Points section. 

Calibration errors are the difference between the calculated pan/tilt values of a fixture, and the 
estimated pan/tilt values of the fixture, based on all measurement points used in the calibration. A 
calibration error residual close to 0, plus or minus 1, is a good indication that the sample was collected 
in a similar way compared to the rest. The quality of the sample should be good for fixture calibration.

A measurement point with a large residual number is an indication that the measurement point was 
collected differently then the other samples. The measurement point could also be too poor in quality to 
be of use in calibration. Such incorrect measurement points should be removed and then calibration 
reapplied to the fixture. 

Note: If when removing measurement points from a fixture you have less then 8 remaining, you will 
have to collect more sample measurement points before recalculating fixture calibration.

To delete measurements point from a fixture

1 In the Fixtures section, in the Fixture List, select the fixture with measurement points you want to 
delete.

2 In the Measurement Points section, select any measurement points you want to delete.

3 Click Delete Point(s).

Result: The selected measurement points will be deleted from the fixture.

Managing Calibration Data

Fixture calibration data can be saved as a calibration (.cal) file separate from of the BlackTrax project. 
Calibration profiles can be loaded and edited as needed in a project.

To export calibration data
Created calibration data can be saved separately from the BlackTrax project as a BlackTrax calibration 
(.cal) file.

1 In the Fixtures section, click Export Calibration.

2 In the dialog widow that opens, navigate to the location where you want to save the calibration file. 

3 In the File Name field, type the name of the calibration session.
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4 Click Save.
Result: Information on any fixtures calibrated will be saved to the calibration file. The information 
will be accurate so long as the calibrated fixtures are not moved or bumped.

To import calibration data

1 In the Fixtures section, click Import Calibration.

2 In the dialog window that opens, browse to the location where the calibration (.cal) file is located.

3 Select the .cal file.

4 Click Open.

Result: The calibration file will load. Fixtures will inherit the calibration data saved in the file.

To apply calibration data to fixture
If calibration data is created but not applied to a fixture, BlackTrax continues using the original fixture 
position. Calibrated fixture positions need to be applied to fixtures for BlackTrax to use the calibration 
data.

Note: A fixture that has a calibrated position available, but is currently not in use, will display as 
Calibrated, Not Used (Yellow).

1 In the Fixtures section, select a fixture that has calibration data created but not in use.

2 In the Calibration Results section, click the Use Calibrated Fixture Position radio.

Result: BlackTrax will use the calibrated fixture position for the fixture. The calibrated value will 
change from Not Used (yellow) to Active (green).

To uncalibrate a fixture

1 In the Fixtures section, in the Fixture List, select the fixture you want to remove all calibration data 
from.

2 In the Measurement Points section, click Delete Fixture Calibration. 

Result: All calibration data and measurement points will be removed from the fixture.

To uncalibrate all fixtures in the project

1 In the Fixtures section, in the Fixture List, click Clear All.

2 A dialog window will appear asking if you really want to clear all calibration data from the project. 
Click Yes.

Result: All calibration data will be removed from all fixtures in the project.
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Control Panel Page

Introduction

The Control Panel page is where a BlackTrax project is controlled. Only information that is applied to 
project file will appear here. Edits made to the opened project on other pages which are not applied 
using Apply Changes will not be shown.

From this page you can connect BlackTrax modules, toggle fixture following, toggle the tracking mode, 
and manage chapter selection and see project information. 

Layout of Control Panel Page 
I. Tracking Control - Controls fixture following and BlackTrax modes. 

1. Start Following/Stop Following - Toggles fixture following On/Off.

2. Enter Calibration /Exit Calibration - Toggles Calibration mode On/Off.

II. BlackTrax Engine Modules - Connected BlackTrax modules.

1. Discover - Connects all linked modules to BlackTrax.

2. Module - Name of the BlackTrax module.

3. Connection - Connection status of modules.

III. Chapter Control - List of all created chapters in the project.

1. Active - Status of the chapter.

2. Name - Name of the chapter

3. Description - Description of the chapter.

4. Control Type - Drop-down list of chapter control options.

IV. Project Information- Read only metadata about the BlackTrax project.

1. Show Name - Name of the BlackTrax project.

2. Author - Author of the BlackTrax project.

3. Description - Description of the BlackTrax project.

4. Creation - Date the BlackTrax project was created.

5. Modification - Date the BlackTrax project was last modified.

6. Calibration - Date BlackTrax project fixtures were last calibrated.

7. Can Calibrate - The project has enough information to run calibration.

8. Can Run Show - The project has enough information to run full fixture tracking.

V. Live Trackables - All live Trackables and assigned BTBeacon in the project.
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BlackTrax Modules

The BlackTrax Engine Modules section, is where the different parts of the BTSystem are connected 
together. The status of all connected modules is shown so you can easily troubleshoot if any part is not 
connected.

Purpose of BlackTrax modules
Each module has a specific role that comes together to create the BTSystem. The following is a brief 
explanation of the various modules:

 Tracker - Determines position of Trackables. Loads automatically with the BlackTrack GUI, 
operates in the background.

 Follower - Sends position data out to fixtures. Loads automatically with the BlackTrack GUI, 
operates in the background.

 Visualizer - WYSIWYG BlackTrax Edition, used to visualize activity in the Space.

To connect modules to BlackTrax

In the Network Clients section, click Discover.

Result: The BlackTrax Engine Modules section will be populated with all linked modules. Modules have to 
be 

Chapter Selection

The Chapter Control section contains a list of created chapters that can be selected to be active. If 
Following is active, assigned fixtures will follow Trackables assigned to the active chapter.

Selection of which chapter is active can be controlled by using manual control in BlackTrax, or using Art-
Net control from a lighting console. 

Manual Chapter Control
Manual control enables control of chapters from within the BlackTrax GUI.

To enable manual control of chapters

In the Chapter Control section, click the drop-down list. From the list, select Manual. 

To select a chapter to be active using manual control

In the Chapter Control section, in the list of created chapters, click the chapter.

Result: The chapter will have an Active Icon in the Active field to show it is currently selected. 
Fixtures assigned in the chapter will follow assigned Trackables in the Space.

Art-Net Chapter Control 
With Art-Net control enable, the selection of which chapter is active can be controlled from a console. 

To enable Art-Net control of chapters

In the Chapter Control section, click the drop-down list. From the list, select Art-Net Input. 

Result: A connected lighting console now has control over chapter selection. Under the Chapter Control 
drop-down list the Universe and Channel which the console will control chapter selection is displayed. 
The Auto Scroll feature is now available as well.
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To toggle auto scrolling to an active chapter
With Art-Net InPut enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the 
chapter list always display the active chapter when enabled.

To toggle auto scrolling, in the Chapter Control section, click Auto Scroll.

Tracking Control

The Tracking Control section is where fixture following and calibration is controlled. When Following is 
enabled, Trackables assigned to the active chapter will have assigned fixtures follow them in the Space. 
When BlackTrax is set to Not Following, fixtures will stop following and revert to positions determined 
by a connected lighting console. When Calibration Mode is active, the features of the Fixture 
Calibration page become enabled. When Normal Mode is active, the Fixture Calibration page becomes 
locked.

Note: To calibrate fixtures, the BTSystem has to have Following and Calibration Mode active at the 
same time

To enable fixtures following Trackables

In the Tracking Control section, click Start Following.

Result: BlackTrax will attempt to connect modules as if Discover was used. A dialog window will appear 
showing the status of modules. If successful the following icon will change to Active. Assigned fixtures 
will now follow Trackables assigned to the active chapter. 

Attention: Any edits made in other pages will be implemented as if Apply Changes was used when the 
BTSystem is set to Following.

To disable fixtures following of Trackables

1 In the Tracking Control section, click Stop following.

2 A dialog window will appear asking if you really want to stop following. Click Yes.

Result: The BTSystem will stop follow with fixtures and the following icon will change to Stopped. 
Assigned fixtures in the active chapter will revert to positions assigned by the connected console.

To enable fixture calibration

In the Tracking Control section, click To Calibration Mode.

Result: BlackTrax will be set to Calibration Mode and the features of the Fixture Calibration page will 
be unlocked. The calibration icon will change to Calibration.

To disable fixture calibration

In the Tracking Control section, click To Normal Mode.

Result: BlackTrax will be set to Normal Mode and the Fixture Calibration page features will be locked. 
The calibration icon will change to Normal.

Project Information

The Live Show tab displays helpful project information that can be used to help manage and track 
changes to a project. The Show Name, Author and Description fields are user created information, 
made in the Project Information section of the Chapter page. The Creation field displays the date when 
the BlackTrax project was first created. The Modification field displays the last time Apply Changes was 
used in the project. The Calibration field displays the last time fixtures were calibrated in the project.
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Live Trackables

The Live Trackables tab displays all Trackables and assigned BTBeacons applied to the project using 
Apply Changes. Only the current BTBeacon information is shown.
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System Page

The System page containing valuable system information well as the ability to configure how 
information is represented in BlackTrax. System information includes a system log, detailed information 
on data imported from WYSIWYG, as well as the BlackTrax version number and general information.

Note: Changes made in the System page will be applied to the project automatically.

Layout of System page
I. General - Section containing basic system information.

1. Unit Setup- A drop-down list to allow switching between Metric and Imperial measurement in 
BlackTrax.

2. Art-Net Patch- Art-Net settings BlackTrax will patch to.

a. Universe - Universe BlackTrax will patch to.

b. Channel - Channel BlackTrax will patch to.

3. System Log- A record of all BlackTrax system events.

a. Time - Time event occurred.

b. Level - The severity of the system event.

c. Message - Detailed explanation of the system event.

d. Enable logging - Toggle to enable/disable logging of main system events.

e. Log Data - Toggle to enable/disable logging of all system data.

f. To File - Toggle to enable/disable recording of the system log to a separate file.

g. Auto Scroll - Toggle to enable/disable automatically scrolling of the system log to 
the current event.

h. Clear - Removes every event from the System Log section.

II. Wysiwyg BTX - Section containing information imported from the WYSIWYG.

1. Motion Patching - Trackable information.

a. Frame Name - Name of the Trackable object in WYSIWYG.

b. Frame Id - Patch name of the Trackable in WYSIWYG, name of Trackable in 
BlackTrax.

2. Consoles - Connected console information.

a. Console Name - Name of connected console.

b. Console Mode - Mode connected console is operating in.

c. Console Ports - Port information of connected console.

d. BB Port - Reserved for internal use.

e. Port - Port which connects the console to BlackTrax.

f. Patched To - Type of universe console is patched to.

3. Lighting Patching - Patch information about connected moving fixtures.

a. Universe - Universe patch type.

b. Spot ID - ID number of fixture.

c. Offset - Channel the fixture starts in the universe.

d. Size - Number of channels fixture occupies in the universe.

e. Fixture - Fixture product information

f. Pan Inverted - Information if the pan is inverted. 
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g. Tilt Inverted - Information if the tilt is inverted. 

h. Profile - Fixture profile the fixture is operating as.

4. Fixture Profiles - Information about connected fixture profiles.

a. Name - Name of fixture profile.

b. Type - Movement type of the fixture.

c. Has Pan/Tilt - Information on the fixture’s pan and tilt capability.

d. Has Zoom- Information on the fixture’s zoom capability.

e. Has Iris -Information on the fixture’s iris capability.

5. User Origin - The offset value from the origin the 

III. System Configuration - Section to edit system behavior. 

1. Editing Behavior - Allows for configuration of basic system behavior.

2. Calibration Setting - Allows for configuration of certain system behavior related to calibration.

IV. About BlackTrax- Section containing information about BlackTrax.

Setting up units of measurement

BlackTrax allows for either metric or imperial measurement to be used. This setting can be changed in 
the Unit Setup section. The default unit settings of BlackTrax is metric. Loading a project will revert 
BlackTrax to the default unit of measurement.

To set the units of measurement

Go to the General tab, in the Unit Setup section click the drop-down list. From the list click to select the 
desired measurement type.

Result: The chosen unit of measurement will apply to the BlackTrax project. 

Setting Art-Net Patch

BlackTrax by default will patch chapter control by Art-Net on Universe 1 and Channel 1. The patch 
information can be changed in the Unit Setup section.

To set Art-Net Patch

1 In the General tab, in the Art-Net Patch section, enter the universe number in the Universe field. 

2 In the Channel field enter the channel number. 

Result: BlackTrax chapter selection will be controlled on the selected universe and channel on the 
connected console

Configuration of system log

The system log is used to display system information about the BlackTrax project. The various features 
of the system log are as follows:

 Enable Logging - Will enable events to be logged in the system log when enable. 
 Log Data - If logging is enabled, will record all data transmitted when enabled. Used primarily for 

debugging purposes.
 To file - Will save the system log to C:\bt_run_time when enabled.
 Auto scroll - Will automatically scroll to the latest event when it is created in the log when 

enabled.
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Note: If logging data To File is enabled, it is possible to accumulate Gigabytes of data in a single day of 
use. It is recommend that the log file be removed periodically to conserve BTSystem memory.

To set the system log as a separate window

In the General tab, double-click the System Log heading.

Result: The System Log window will now display as a seperate window.

To reattached the system log window to BlackTrax

In the System Log window, in the top right of the window, click Attach.

Result: The System Log window will now reattach to the General tab.

Setting system behavior

BlackTrax allows for the configuration of how it behaves in certain instances. The prompt section allows 
for toggling certain system prompts On/Off.

To toggle a system prompt

In the System Configuration tab, in the Editing Behavior section, click the checkbox to toggle the system 
prompt.
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Important Product Information

This appendix contains safety information and declarations that may be valuable to the user. 

In this appendix
FCC/ IC Information  88
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FCC/ IC Information

FCC/ IC Information:

This device complies with Part 15 of the FCC Rules and with Industry Canada License-exempt RSS 
standard(s). Operation is subject to the following two conditions: 

 (1) this device may not cause harmful interference, and 
 (2) this device must accept any interference received, including interference that may cause 

undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. 

However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

 Reorient or relocate the receiving antenna.
 Increase the separation between the equipment and receiver.
 Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
 Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment, not expressly approved by CAST Group of Companies Inc. 
could void the user’s authority to operate the equipment.
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Ce dispositif est conforme à la norme 15 des règlements de la FCC et des standards CNR d’exempts de 
licence d’Industrie Canada. Son fonctionnement est soumis aux deux conditions suivantes:

 (1) cet appareil ne peut causer d’interférence nuisible, et
 (2) cet appareil doit accepter toute interférence reçue, y compris les interférences pouvant 

provoquer un fonctionnement non désiré. 

REMARQUE : Cet équipement a été testé et déclare conforme aux limites imposées aux appareils 
numériques de Classe B, telles que définie dans l’article 15 des règlements de la FCC. Ces limites sont 
destinées à protéger de façon raisonnable contre les perturbations nuisibles qui peuvent apparaitre 
dans une installation résidentielle. Cet équipement génère, utilise et peut radier de l’énergie de 
fréquence radiophoniques. S’il n’est pas installé et utilisé conformément aux instructions, peut causer 
des interférences radiophoniques nuisibles. 

Toutefois, il n’existe aucune garantie que des interférences ne se produiront pas dans une installation 
particulière. Si cet équipement produit de l’interférence nuisible à la réception radio ou TV, ce qui peut 
être détecté en mettant ou coupant le contact, l’utilisateur sera contraint d’essayer de corriger la 
situation par un ou plusieurs des moyens suivants :

 Réorienter ou relocaliser l’antenne de réception
 Augmenter la distance entre l’équipement et le récepteur
 Raccorder l’équipement dans une prise ou sur un autre circuit que celui du récepteur 
 Demander l’aide du distributeur ou d’un technicien expérimenté en radio et télévision

Tout changement ou modification sans l’autorisation expresse de CAST Group of Companies Inc. 
pourrait annuler le droit d’utiliser cet équipement.
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